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Preface

This guide describes how to install, configure and use VERITAS NetBackup for Sybase on 
UNIX. In this guide, VERITAS NetBackup for Sybase on UNIX is referred to as NetBackup 
for Sybase on UNIX. 

For specific information about the NetBackup server software, refer to: 

◆	 NetBackup System Administrator’s Guide for UNIX, Volumes I and II, if you have a UNIX 
server. 

or 

◆	 NetBackup System Adminstrator’s Guide for Windows, Volumes I and II if you have a 
Windows server. 

This document is the same as NetBackup_AdminGuide_Sybase_Unix.pdf 
distributed with the NetBackup for Sybase on UNIX software. 
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Audience 
Audience 
This guide is intended for the: 

◆	 SYBASE database system administrator responsible for configuring and using the 
SYBASE SQL Server and Backup Server to back up and restore SYBASE databases. 

◆ NetBackup system administrator responsible for configuring NetBackup. 

A system administrator is defined as a person with system administrator privileges and 
responsibilities. 

This guide assumes: 

◆ A basic understanding of system administration. 

◆ A working understanding of the NetBackup client and server software. 

◆ A familiarity with the information covered in the following NetBackup manuals: 

◆ NetBackup Backup, Archive, and Restore Getting Started Guide 

◆	 NetBackup System Administrator’s Guide for UNIX, Volumes I and II or NetBackup 
System Adminstrator’s Guide for Windows, Volumes I and II 

◆ NetBackup Troubleshooting Guide for UNIX and Windows 

◆ A thorough understanding of the following Sybase database topics: 

◆ SYBASE administration 

◆ SYBASE commands 

◆ SYBASE Backup Server Archive API (Application Program Interface) 

What Is In This Guide? 
This guide is organized as follows: 

◆ Chapter 1, “Introduction,” is an overview of the product’s capabilities. 

◆	 The Installation chapter explains how to install NetBackup for Sybase on UNIX on 
your system. 

◆	 Configuration explains how to configure your system to use NetBackup for Sybase on 
UNIX. This information supplements the NetBackup for Sybase on UNIX manuals. 

◆	 Chapter 4, “Using NetBackup for Sybase on UNIX,” explains how to use this product 
to back up and restore your Sybase databases. This information supplements the 
NetBackup manuals. 

◆ Finally, the Troubleshooting chapter provides troubleshooting information. 
viii NetBackup for Sybase System Administrator’s Guide for UNIX 



Getting Help 
Getting Help 
VERITAS offers you a variety of support options. 

Accessing the VERITAS Technical Support Web Site 

The VERITAS Support Web site allows you to: 

◆	 obtain updated information about NetBackup for Sybase, including system 
requirements, supported platforms, and supported peripherals 

◆ contact the VERITAS Technical Support staff and post questions to them 

◆ get the latest patches, upgrades, and utilities 

◆ view the NetBackup for Sybase Frequently Asked Questions (FAQ) page 

◆ search the knowledge base for answers to technical support questions 

◆ receive automatic notice of product updates 

◆ find out about NetBackup for Sybase training 

◆ read current white papers related to NetBackup for Sybase 

The address for the VERITAS Technical Support Web site follows: 

◆ http://support.veritas.com 

Subscribing to VERITAS Email Notification Service 

Subscribe to the VERITAS Email notification service to be informed of software alerts, 
newly published documentation, Beta programs, and other services. 

Go to http://support.veritas.com. Select a product and click “E-mail Notifications” on the 
right side of the page. Your customer profile ensures you receive the latest VERITAS 
technical information pertaining to your specific interests. 

Accessing VERITAS Telephone Support 

Telephone support for NetBackup for Sybase is only available with a valid support 
contract. To contact VERITAS for technical support, dial the appropriate phone number 
listed on the Technical Support Guide included in the product box and have your product 
license information ready for quick navigation to the proper support group. 
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NetBackup for Sybase Manuals 
▼ To locate the telephone support directory on the VERITAS web site 

1. Open http://support.veritas.com in your web browser. 

2.	 Click the Phone Support icon. A page that contains VERITAS support numbers from 
around the world appears. 

Accessing VERITAS E-mail Support 

▼ To contact support using E-mail on the VERITAS web site 

1. Open http://support.veritas.com in your web browser. 

2.	 Click the E-mail Support icon. A brief electronic form will appear and prompt you to: 

◆ Select a language of your preference 

◆ Select a product and a platform 

◆ Associate your message to an existing technical support case 

◆ Provide additional contact and product information, and your message 

3. Click Send Message. 

Contacting VERITAS Licensing 

For license information call 1-800-634-4747 option 3, fax 1-650-527-0952, or e-mail 
amercustomercare@veritas.com. 

NetBackup for Sybase Manuals 
The following manuals, along with the online help, are included in the NetBackup for 
Sybase documentation set. For a more detailed listing of NetBackup documents, refer to 
NetBackup Release Notes for UNIX and Windows. 

If you have a UNIX server, refer to these documents: 

◆ VERITAS NetBackup System Administrator's Guide for UNIX, Volume I 

NetBackup_AdminGuideI_UNIXServer.pdf 

Explains how to configure and manage NetBackup on a UNIX server, including 
managing storage units, backup policies, catalogs and host properties. 

◆ VERITAS NetBackup System Administrator's Guide for UNIX, Volume II 
x NetBackup for Sybase System Administrator’s Guide for UNIX 



Sybase Manuals 
NetBackup_AdminGuideII_UNIXServer.pdf 

Explains additional NetBackup features such as notify scripts, enhanced 
authorization and authentication, and role-based security. The guide also discusses 
using NetBackup with AFS, Intelligent Disaster Recovery (IDR), and the BE Tape 
Reader. 

◆ NetBackup Media Manager System Administrator’s Guide for UNIX 

Explains how to configure and manage the storage devices and media on UNIX 
NetBackup servers. Media Manager is part of NetBackup. 

◆ VERITAS NetBackup Troubleshooting Guide for UNIX and Windows 

Provides troubleshooting information for UNIX- and Windows-based NetBackup 
products, including Media Manager. 

If you have a Windows server, refer to these documents: 

◆ VERITAS NetBackup System Administrator’s Guide for Windows, Volume I 

NetBackup_AdminGuideI_WinServer.pdf 

Explains how to configure and manage NetBackup on a Windows server, including 
managing storage units, backup policies, catalogs and host properties. 

◆ VERITAS NetBackup System Administrator’s Guide for Windows, Volume II 

NetBackup_AdminGuideII_WinServer.pdf 

Explains additional NetBackup features such as notify scripts, enhanced 
authorization and authentication, and role-based security. The guide also discusses 
using NetBackup with AFS, Intelligent Disaster Recovery (IDR), and the BE Tape 
Reader. 

◆ NetBackup Media Manager System Administrator’s Guide for Windows 

Explains how to configure and manage the storage devices and media on Windows 
NetBackup servers. Media Manager is part of NetBackup. 

◆ VERITAS NetBackup Troubleshooting Guide for UNIX and Windows 

Provides troubleshooting information for UNIX- and Windows-based NetBackup 
products, including Media Manager. 

Sybase Manuals 
For this product, you may also need the following Sybase manuals (available from 
Sybase): 

◆ SYBASE SQL Server Installation and Configuration Guide 
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Glossary 
◆ SYBASE SQL Server System Administration Guide. 

◆ SYBASE SQL Server Utility Programs for UNIX 

◆ SQL Server Configuration Guide 

Glossary 
If you encounter unfamiliar terminology, consult the NetBackup online glossary. The 
glossary contains terms and definitions for NetBackup and all additional NetBackup 
options and agents. 

The NetBackup online glossary is included in the NetBackup help file. 

▼ To access the NetBackup online glossary 

1. In the NetBackup Administration Console, click Help > Help Topics.


2. Click the Contents tab.


3. Click Glossary of NetBackup Terms.


Use the scroll function to navigate through the glossary.


Accessibility Features 
NetBackup contains features that make the user interface easier to use by people who are 
visually impaired and by people who have limited dexterity. Accessibility features 
include: 

◆	 Support for assistive technologies such as screen readers and voice input (Windows 
servers only) 

◆	 Support for keyboard (mouseless) navigation using accelerator keys and mnemonic 
keys 

For more information, see the NetBackup System Administrator’s Guide for Windows, 
Volume I or the NetBackup System Administrator’s Guide for UNIX, Volume I. 

Conventions 
The following conventions apply throughout the documentation set. 
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Product-Specific Conventions 

The following term is used in the NetBackup for Sybase 5.1 documentation to increase 
readability while maintaining technical accuracy. 

◆ Microsoft Windows, Windows 

Terms used to describe a specific product or operating system developed by 
Microsoft, Inc. Some examples you may encounter in NetBackup documentation are, 
Windows servers, Windows 2000, Windows Server 2003, Windows clients, Windows 
platforms, or Windows GUI. 

When Windows or Windows servers is used in the documentation, it refers to all of 
the currently supported Windows operating systems. When a specific Windows 
product is identified in the documentation, only that particular product is valid in that 
instance. 

For a complete list of Windows operating systems and platforms that NetBackup 
supports, refer to the NetBackup Release Notes for UNIX and Windows or go to the 
VERITAS support web site at http://www.support.veritas.com. 

Typographical Conventions 

Here are the typographical conventions used throughout the manuals: 

Conventions 

Convention Description 

GUI Font	 Used to depict graphical user interface (GUI) objects, such as fields, 
listboxes, menu commands, and so on. For example: Enter your 
password in the Password field. 

Italics	 Used for placeholder text, book titles, new terms, or emphasis. Replace 
placeholder text with your specific text. For example: Replace filename 
with the name of your file. Do not use file names that contain spaces. 

This font is also used to highlight NetBackup server-specific or operating 
system-specific differences. For example: This step is only applicable for 
NetBackup Enterprise Server. 

Code	 Used to show what commands you need to type, to identify pathnames 
where files are located, and to distinguish system or application text that 
is displayed to you or that is part of a code example. 

Key+Key	 Used to show that you must hold down the first key while pressing the 
second key. For example: Ctrl+S means hold down the Ctrl key while 
you press S. 
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You should use the appropriate conventions for your platform. For example, when 
specifying a path, use backslashes on Microsoft Windows and slashes on UNIX. 
Significant differences between the platforms are noted in the text. 

Tips, notes, and cautions are used to emphasize information. The following samples 
describe when each is used. 

Tip Used for nice-to-know information, like a shortcut. 

Note	 Used for important information that you should know, but that shouldn’t cause any 
damage to your data or your system if you choose to ignore it. 

Caution	 Used for information that will prevent a problem. Ignore a caution at your own 
risk. 

Command Usage 

The following conventions are frequently used in the synopsis of command usage. 

brackets [ ] 

The enclosed command line component is optional. 

Vertical bar or pipe (|) 

Separates optional arguments from which the user can choose. For example, when a 
command has the following format: 

command arg1|arg2


In this example, the user can use either the arg1 or arg2 variable. 

Navigating Multiple Menu Levels 

When navigating multiple menu levels, a greater-than sign (>) is used to indicate a 
continued action. 

The following example shows how the > is used to condense a series of menu selections 
into one step: 

❖	 Select Start > Programs > VERITAS NetBackup > NetBackup Administration 
Console. 

The corresponding actions could be described in more steps as follows: 

1. Click Start in the task bar. 

2. Move your cursor to Programs. 
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3. Move your cursor to the right and highlight VERITAS NetBackup. 

4.	 Move your cursor to the right. First highlight and then click NetBackup 
Administration Console. 
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NetBackup for Sybase on UNIX integrates the database backup and recovery capabilities 
of Sybase ASE Backup Server with the backup and recovery management capabilities of 
NetBackup and Media Manager. 

This chapter introduces NetBackup for Sybase on UNIX and explains how it relates to 
both Sybase ASE Backup Server and NetBackup. Read this chapter for a description of: 

◆ Features of NetBackup for Sybase on UNIX 

◆ Terminology for NetBackup for Sybase on UNIX 

◆ Technical Overview of NetBackup for Sybase on UNIX 
1 
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Features of NetBackup for Sybase on UNIX 
This section describes the NetBackup for Sybase on UNIX main features. 

NetBackup for Sybase on UNIX main features 

Feature Description 

Media and device 
management 

Scheduling facilities 

Multiplexed backups and 
restores 

Transparent execution of 
both Sybase and regular 
file system backup and 
restore operations 

Sharing the same devices 
and tapes used during 
other file backups 

Centralized and 
networked backup 
operations 

All devices supported by Media Manager are available to 
NetBackup for Sybase on UNIX. 

NetBackup scheduling facilities on the master server can be 
used to schedule automatic and unattended Sybase backups. 

This also lets you choose the times when these operations can 
occur. For example, to prevent interference with normal 
daytime operations, you can schedule your database backups 
to occur only at night. 

NetBackup for Sybase on UNIX lets you take advantage of 
NetBackup’s multiplexing capabilities. Multiplexing directs 
multiple data streams to one backup device, thereby reducing 
the time necessary to complete the operation. 

All backups and restores are run simultaneously and 
transparently without any action from the NetBackup 
administrator. 

A Sybase administrator can run database backup and restore 
operations through NetBackup or use Sybase ASE Backup 
Server as if NetBackup were not present. 

An administrator or any other authorized user can use 
NetBackup to run database backups and restores. 

It is possible to share the same devices and media used for 
other backups or to give Sybase exclusive use of certain 
devices and media. 

From the NetBackup master server, you can schedule 
database backups or start them manually for any client. The 
Sybase databases can also reside on hosts that are different 
from the devices on which NetBackup stores the backups. 
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NetBackup for Sybase on UNIX main features 

Feature Description 

Graphical user interfaces	 NetBackup provides the following graphical user interfaces 
for client users and administrators: 

◆ Backup, Archive, and Restore user interface 

◆ Client user motif interface, xbp 

◆ NetBackup Administration Console for Java 

◆ NetBackup Administration Console for Windows 

A database administrator or NetBackup administrator can 
start backup operations for Sybase from the NetBackup 
graphical user interface on the master server. 

Parallel backup and NetBackup for Sybase on UNIX supports the parallel backup 
restore operations	 and restore capabilities of the Sybase ASE Backup Server. This 

permits the user to run more than one tape device at a time for 
a single Sybase ASE backup or restore, thereby reducing the 
time necessary to complete the operation. 
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Terminology for NetBackup for Sybase on UNIX 
This section explains important terms that may be new to a Sybase database administrator 
or a NetBackup administrator. 

NetBackup Terms 
This section describes NetBackup terms as they apply to NetBackup for Sybase on UNIX. 

NetBackup 

NetBackup policy 

NetBackup schedule 

Administrator-directed 
backups 

User-directed backups and 
restores 

Graphical interfaces 

Media Manager 

NetBackup backs up and restores files, directories, raw partitions, and 
databases on client systems that have Sybase databases. 

NetBackup policies define criteria for backups and restores. These 
criteria include storage unit and media to use, backup schedules, 
clients, files to back up, or backup templates or scripts to execute. 

NetBackup schedules control NetBackup operations such as: when 
backups can occur, the type of backup (full, incremental) to perform, 
and how long NetBackup retains the image (retention level). 

NetBackup administrators are able to perform remote backups of all 
files, directories, databases, and raw partitions contained on client 
systems within a client/server network via NetBackup interfaces. 

NetBackup users are able to perform backups of all files, directories, 
databases, and raw partitions contained on client systems within a 
client system. 

Graphical user interfaces are available for both users and 
administrators. 

The Media Manager provides complete management and tracking of 
all devices and media used during backups and restores. 

For explanations of other NetBackup terms, consult the NetBackup online glossary. For 
instructions, see the “Glossary” section in the Preface. 
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NetBackup for Sybase on UNIX Terms 

SQL Server and Sybase SQL Server improves the backup and restore functions of 
ASE Backup Server	 Sybase ASE Backup Server by using remote-procedure calls to 

instruct Sybase ASE Backup Server to back up or restore specific 
databases. 

NetBackup for Sybase on UNIX enhances SQL Server 
functionality by integrating Sybase ASE Backup Server with 
NetBackup. This provides access to NetBackup 
media-management and scheduling in addition to graphical 
and menu interfaces. 

SQL Server DUMP and 
LOAD commands 

These SQL Server commands are used for Sybase ASE database 
backups and restores. The DUMP command is used to back up. 
The LOAD command is used to restore. 

Archive device	 This dump-device is used with the DUMP and LOAD commands. 
It is required to support integration with NetBackup for Sybase 
on UNIX. 

Sybase backup scripts Shell scripts that control NetBackup for Sybase operations. 

Sybase SQL script	 An SQL script that contains SQL commands to be performed by 
Sybase SQL Server. 

Sybase Adaptive Server A powerful data management platform for mission-critical, 
transaction-intensive enterprise applications.Enterprise 

Sybase ASE Sybase Adaptive Server Enterprise. 
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Technical Overview of NetBackup for Sybase on UNIX 
The following illustration shows the major components in a NetBackup for Sybase on 
UNIX configuration. 

Example NetBackup for Sybase Configuration 

System containing Sybase database 

NetBackup master server 
or remote media server 

Sybase database software supplies: 

– SQL Server 
– Backup Server 

Network (TCP/IP) 

NetBackup for Sybase supplies: 

– Dynamically Loadable Library 
– Sample script files 

NetBackup software: 

– NetBackup Master Server 

Additional required NetBackup software: 

– NetBackup Master Server 
– NetBackup Client 

Tape or optical 
storage device 

Sybase database 

host saturn 

host jupiter 

– NetBackup Media Server 
(if system is a media server) 

The main elements to this example configuration are: 

◆	 The Sybase database host, in this example, “saturn,” which contains SQL Server, 
Sybase ASE Backup Server, NetBackup for Sybase on UNIX, and NetBackup client 
software. Refer to “SQL Server and Sybase ASE Backup Server” on page 7 and 
“NetBackup for Sybase on UNIX” on page 7 for more details. 

◆	 The NetBackup server, in this example, “jupiter,” which contains NetBackup server 
software. Refer to the NetBackup System Administrator’s Guide for UNIX, Volumes I and 
II or NetBackup System Adminstrator’s Guide for Windows, Volumes I and II for more 
details on the NetBackup server. 
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◆	 The storage media is connected to the NetBackup master server. Refer to the 
NetBackup Media Manager System Administrator’s Guide for UNIX or the NetBackup 
Media Manager System Administrator’s Guide for Windows for more details on the 
NetBackup Media Manager. 

SQL Server and Sybase ASE Backup Server 
SQL Server performs Sybase ASE backups and restores by sending Sybase ASE DUMP and 
LOAD directives to Sybase ASE Backup Server. Sybase ASE Backup Server is an Open 
Server application that prevents backup and restore tasks from interfering with user 
processes. SQL Server and Sybase ASE Backup Server are installed and configured with 
Sybase ASE’s regular installation facilities. 

When either a Sybase ASE DUMP or LOAD command is processed, SQL Server sends 
Sybase ASE Backup Server the directives to dump or load the specified database or 
transaction log. These directives indicate which set of archive devices to use for the dump 
image. Sybase ASE Backup Server then handles all data transfer for the operation. 

For more information on SQL Server and Sybase ASE Backup Server, refer to the SYBASE 
SQL Server Installation and Configuration Guide for your platform and the SYBASE SQL 
Server System Administration Guide. 

NetBackup for Sybase on UNIX 
NetBackup for Sybase on UNIX has a dynamically-loadable library that provides the 
functions necessary for Sybase ASE Backup Server to use NetBackup. This library is 
installed when NetBackup for Sybase on UNIX is installed. 

NetBackup for Sybase on UNIX is integrated with Sybase ASE Backup Server through the 
Sybase ASE Backup Server Archive API. Sybase ASE Backup Server uses the Archive API 
routines to issue I/O requests to an archive-byte stream. At run time, Sybase ASE Backup 
Server loads the NetBackup for Sybase on UNIX library and makes calls to the API 
routines to open, close, read, and write to the byte stream through this API interface. 

The dump-device string of the Sybase ASE DUMP and LOAD commands is extended to 
support the Archive API. The following syntax instructs Sybase ASE Backup Server to use 
the NetBackup archive device to transfer data to and from NetBackup. 

"sybackup::"


The Sybase ASE DUMP command appears as follows: 

dump database model to "sybackup::"
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SQL Server and Sybase ASE Backup Server do not have a backup-catalog feature. 
However, when you perform a database or transaction dump, NetBackup for Sybase on 
UNIX automatically creates a file name for the dump image. You must then specify this 
file name during a subsequent load operation. 

The file naming convention for the database and transaction dumps is the following: 

sql_server_name.database_name.backup_type.stripe_number.pid.dd-mm-yyyy.hh:mm:ss


Where backup_type is D for database and T for transaction. 

For example: 

SYBASE11.mydb.D.0.24312.17-12-2003.14:05:25


Sequence of Operation 
NetBackup operations are controlled by Sybase script files. A user selects a script through 
the NetBackup client user interface. Refer to “Using NetBackup for Sybase on UNIX” on 
page 75 for details. A schedule is configured, through the NetBackupAdministration 
Console, to use a script to perform NetBackup operations. Refer to “Configuration” on 
page 25 for details. 

The following process takes place when a script is selected for a backup: 

1. A NetBackup process called bphdb starts the Sybase backup script on the client. 

2.	 The Sybase backup script then starts the isql utility with the Sybase SQL script as an 
input file. 

3. SQL Server starts the requested operation on the databases. 

4.	 When the process requires media to store backup data, NetBackup for Sybase on 
UNIX starts a user-directed backup by using the NetBackup bpbackup command. 

5.	 The NetBackup master server then connects to NetBackup for Sybase on UNIX on the 
client. 

6.	 Sybase ASE Backup Server sends data to NetBackup for Sybase on UNIX, which 
transfers data to the master server. 

7. The master server sends the data to a storage unit. 

A restore works in essentially the same manner except that NetBackup for Sybase on 
UNIX issues a bprestore command. This causes the master server to retrieve the data 
from the storage unit and send it to NetBackup for Sybase on UNIX on the client. 
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Since Sybase ASE Backup Server supports parallel operations, it is possible to start more 
than one backup or restore operation. 

Note	 The Sybase ASE Backup Server API does not support the Remote Sybase ASE 
Backup Server feature. All network communications are controlled by NetBackup. 
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Installation 
2


This chapter describes the NetBackup for Sybase on UNIX installation and setup 
procedures. It includes a section on installation prerequisites. 

▼ To locate the latest Database Agent information on the VERITAS support web site 

1. Go to the VERITAS support web page: http://www.support.veritas.com. 

2.	 From the Select Product Family list, choose NetBackup Products. The Select Product 
window refreshes showing a list of NetBackup products. 

3.	 Select one of the NetBackup products. The page refreshes and displays a search 
window with four tabs. 

4. Select 5.1 in the Product Version drop-down field. 

5. Select a Product Platform. 

6.	 Click the Compatibility tab. The page refreshes showing documents that contain 
compatibility information. 

7.	 Click on the title of the document link for NetBackup Database Agent Compatibility 
List. A document appears that contains a downloadable file that enables you to view 
the supported database spreadsheet for this release. 
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Installation Prerequisites 
Before installing NetBackup for Sybase on UNIX, be sure you have completed the 
following procedures: 

❖	 Install the Sybase vendor software on the client where you will be backing up the 
databases. 

See the Sybase SQL Server Installation and Configuration Guide for instructions on 
installing Sybase ASE. 

❖ Install the NetBackup server software on the server. 

The NetBackup server platform can be any of those that NetBackup supports. 

Refer to the NetBackup Installation Guide for UNIX or the NetBackup Installation Guide 
for Windows. 

❖	 Install the NetBackup client software on the client where you will be backing up the 
databases. 

Refer to the NetBackup Installation Guide for UNIX for installation instructions. 

Now you are ready to install NetBackup for Sybase on UNIX on the client where you will 
be backing up the databases. Refer to the next section for detailed instructions on 
installing NetBackup for Sybase on UNIX. 

Guidelines for Installing NetBackup for Sybase on UNIX in a 
Cluster 

◆	 Prior to installing NetBackup for Sybase on UNIX, the NetBackup server must be 
installed and configured to work in a cluster. (This is accomplished by following the 
instructions in the NetBackup Installation Guide for UNIX, including running the 
cluster_config script after the NetBackup server software has been installed.) 

◆	 Commands such as bpplclients and update_dbclients must be run from the 
active NetBackup node. If you are pushing the database agent software to clients 
located in a cluster, specify the individual node names (not virtual names) in the list of 
clients. 

◆	 If installing NetBackup for Sybase on UNIX on a clustered NetBackup server, freeze 
the active NetBackup node before beginning the installation. Install on all the inactive 
nodes, then install on the active node. After you successfully install on the active 
node, unfreeze this node. 
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◆	 The cluster_config script only needs to be run after the NetBackup server 
software has been installed. You do not need to run this script after installing 
NetBackup for Sybase on UNIX on a NetBackup server or if you wish to install 
NetBackup for Sybase on UNIX on a machine on which only the NetBackup client is 
installed. 
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Installing NetBackup for Sybase on UNIX 
There are two ways to install database agent software. 

◆	 Remote installation: Loads the software on a master server. The user then pushes the 
database software out to affected clients. 

Refer to the following section. 

◆ Local installation: Loads and installs the software only to the local machine. 

Refer to “Local Installation of NetBackup for Sybase on UNIX” on page 19. 

Remote Installation of NetBackup for Sybase on UNIX 
During a remote installation, NetBackup for Sybase on UNIX files are loaded onto the 
current machine, which must be a UNIX master server. The software is then distributed to 
the clients and installed. 

Note	 In a clustered environment, the capability to push client software is only available 
from the active node. 

Installation Requirements 

◆	 The version of the NetBackup client and the version of NetBackup for Sybase on 
UNIX must be the same (for example, 5.1). 

◆ There must be adequate disk space on each client that will receive the software. 

Less than one megabyte of additional disk space is required in the client’s 
install_path/netbackup directory. However, more disk space may be necessary 
at run time. 

◆	 NetBackup version 5.1 client software is installed and operational on each Sybase 
client. 

This also means that the directory install_path/netbackup already exists on 
each Sybase client. 

◆	 In a clustered environment, NetBackup server software has been installed and 
configured to work in a cluster. (This is accomplished by following the instructions in 
the NetBackup Installation Guide for UNIX, including running the cluster_config 
script after the NetBackup server software is installed.) 
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Remote Installation Instructions 

▼ To perform a remote installation 

1.	 If installing NetBackup for Sybase on UNIX on a clustered NetBackup server, first 
refer to the “Guidelines for Installing NetBackup for Sybase on UNIX in a Cluster” 
earlier in this chapter. 

2.	 Log in as the root user on the server. 

If you are already logged in, but are not the root user, run the following command. 

su - root


3.	 Make sure a valid license key for NetBackup for Sybase on UNIX has been registered. 
To view or add license keys, perform one of the following: 

◆ Run the following command: 

install_path/netbackup/bin/admincmd/get_license_key. 

◆ Open the NetBackup Administration Console and choose Help > License Keys. 

4. Insert the CD-ROM into the drive. 

5.	 Change the working directory to the CD-ROM directory. 

cd /CD_mount_point 

6.	 Load the software on the server by executing the install script. 

./install 

a.	 Select the NetBackup Database Agent Software option. 

The following prompt appears: 

Do you want to do a local installation? (y/n) [n]


b.	 Answer n. 

You are presented with a menu of all database agents available on the CD-ROM. 

c. Select the NetBackup for Sybase option. 

d.	 Enter q to quit selecting options. 

A prompt appears asking if the list is correct. 

e. Answer y. 
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The install script identifies the types of client software loaded during the 
installation of the NetBackup server. By default, any matching NetBackup for 
Sybase on UNIX  software is automatically loaded. If there are more platforms 
available, the script displays a menu giving you the opportunity to add more 
client types to the default list. Once the list is complete, database agent version 
files, compressed tar files and the install_dbext script are copied to directory 
install_path/netbackup/dbext. 

7.	 Distribute and install the NetBackup for Sybase on UNIX  software on each client as 
described in the next sections. 

Note	 In a clustered environment, the capability to distribute client software is only 
available from the active node. 

There are two types of installation processes. 

◆	 initial install: Use an initial install if the clients you intend to update have not been 
added to policies of type Sybase. 

◆	 upgrade install: Use an upgrade install if all the clients you intend to update 
already have been added to policies of type Sybase. 

Note	 The NetBackup version level (for example, 5.1) running on the clients you wish to 
update must be the same as the version level of the NetBackup for Sybase on UNIX 
being installed. 

Initial Installation on Clients 

▼ To perform an initial install on the clients 

1.	 Run the following command to create a file containing a list of clients currently 
configured in the NetBackup database. 

cd install_path/netbackup/bin

./admincmd/bpplclients -allunique -noheader > filename


where filename is the name of the file to contain the list of unique clients. If no 
clients have been configured in the NetBackup database, and therefore filename is 
empty, create filename using the same format as that generated by bpplclients. 

bpplclients generates output in following format: 

hardware operating_system client_name 
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where: 

hardware is the hardware name. For example, execute the ls command in 
directory install_path/netbackup/client. 

operating_system is the operating system name. For example, execute the ls 
command in directory install_path/netbackup/client/hardware. 

client_name is the name of the client. 

For example, the contents of filename might look like this: 

Solaris Solaris8 curry

RS6000 AIX4.3.3 cypress


2. Edit filename. 

This is an optional step. Use it if the contents of filename need to be changed. Edit 
filename to contain only those clients you wish to update with NetBackup for Sybase 
on UNIX  software. 

Note If you are pushing the database agent software to clients located in a cluster, specify 
the hostnames of the individual nodes (not virtual names) in the list of clients. 

3. Specify filename in the update_dbclients command. 

For example: 

cd install_path/netbackup/bin 
./update_dbclients Sybase -ClientList filename 

Only clients listed in filename are updated. 

Note	 If the receiving client is configured as an HP-UX11.00, HP-UX11.11, Solaris7, 
Solaris8, or Solaris9, both the 32-bit and 64-bit versions of NetBackup for Sybase on 
UNIX will be installed. 

Upgrade Installation on Clients 

▼ To perform an upgrade installation on the clients 

1. Execute the following command. 

cd install_path/netbackup/bin

./update_dbclients Sybase ALL ALL


This command looks at all possible clients and updates only the clients currently in 
the Sybase policy type. 
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Instead of ALL ALL, you may use -ClientList filename as explained in “Initial 
Installation on Clients” on page 16. 

Note If you are pushing the database agent software to clients located in a cluster, specify 
the hostnames of the individual nodes (not virtual names) in the list of clients. 

Note	 If the receiving client is configured as an HP-UX11.00, HP-UX11.11, Solaris7, 
Solaris8, or Solaris9, both the 32-bit and 64-bit versions of NetBackup for Sybase on 
UNIX will be installed. 

Note	 With an initial or upgrade install, some clients may be skipped and not updated. 
Possible reasons are: 
- the client is a PC client (which cannot be updated from a UNIX server) 
- NetBackup for Sybase on UNIX  does not support that client's platform type 
- the NetBackup for Sybase on UNIX  software for that client type was not loaded 
onto the server in step 6 of the “Remote Installation Instructions” on page 15 
- (if using the ALL ALL method) the client does not belong to the Sybase policy type 
All skipped clients are available in a file whose name is displayed by 
update_dbclients. 

The number of updates required to distribute the software to the clients is displayed.


If more than one update will occur, you will see the following prompt:


Enter the number of simultaneous updates you wish to take place. 1 - max dflt


(must be in the range of 1 to max; default: dflt). 

where: 

max is the maximum number of simultaneous updates that is allowed. The value 
displayed ranges from 1 to 30. 

dflt is the default number the program uses if you press Enter. The value 
displayed ranges from 1 to 15. 

For example, if three client updates will be performed, the max and dflt values shown 
would be 3. If 50 client updates will be performed, the max value shown would be 30 
and the dflt value shown would be 15. 

update_dbclients starts the number of updates that you specify. If this number is 
less than the total number of client updates to be performed, new updates start as the 
previous updates finish until all of the updates have been completed. 

Based on your answer, the time it will take to update the clients is displayed, followed 
by this question: 

Do you want to upgrade the clients now? (y/n) [y]
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2. Enter y or n for the prompt. 

If you answer n, update_dbclients quits and leaves the list of clients it would 
have updated in a file. This file can later be used by the -ClientList parameter 
mentioned previously. 

Answer y to continue the installation process. 

If the update_dbclients command was successful in distributing the software to the 
client, it automatically runs the install_dbext script on the client. If install_dbext 
has successfully completed, there will be a version file in directory 
install_path/share that contains the version of NetBackup for Sybase on UNIX  that 
was installed. The update_dbclients command displays a note on whether the update 
was successful for each client. When the update_dbclients command has completed, 
it displays a file name that contains a complete log of what happened for each client. If the 
update failed for any client, the log file should be examined to determine the problem. 

Local Installation of NetBackup for Sybase on UNIX 
During a local installation, the NetBackup for Sybase on UNIX files are extracted and 
installed. The local machine can be a client or a master server that also happens to be a 
client. 

Installation Requirements 

◆	 The version of the NetBackup client and the version of NetBackup for Sybase on 
UNIX are the same (for example, 5.1). 

◆ The local machine must have adequate disk space. 

Less than one megabyte of additional disk space is required in the 
install_path/netbackup directory. However, more disk space may be necessary 
at run time. 

◆ NetBackup version 5.1 client software is installed and operational. 

This also means that the install_path/netbackup directory already exists. 

◆	 In a clustered environment, NetBackup server has been installed and configured to 
work in a cluster. (This is accomplished by following the instructions in the NetBackup 
Installation Guide for UNIX, including running the cluster_config script after 
installing the NetBackup server software.) 
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Local Install Instructions 

▼	 To install NetBackup for Sybase on UNIX to the local machine 

1. Log in as the root user on the machine. 

If you are already logged in, but are not the root user, run the following command. 

su - r oot


◆ If the local machine is a client, go to step 3.


◆ If the local machine is a server, go to step 2.


2.	 Make sure a valid license key for NetBackup for Sybase on UNIX has been registered. 
In a NetBackup server clustered environment, the license key must be registered on 
each node. To view or add license keys, perform one of the following: 

◆	 Run the command 
install_path/netbackup/bin/admincmd/get_license_key. 

◆ Open the NetBackup Administration Console and choose Help > License Keys. 

3. Insert the CD-ROM into the drive. 

4.	 Change the working directory to the CD-ROM directory. 

cd /CD_mount_point 

5. Load and install the software by executing the install script. 

Note	 It is expected that the NetBackup version level (for example, 5.1) running on the 
local machine matches the version level of the database agent being installed. 

./install


a.	 Select the NetBackup Database Agent Software option. 

The following prompt appears: 

Do you want to do a local installation? (y/n) [n]


b.	 Answer y. 

You are presented with a menu of all database agents available on the CD-ROM. 

c. Select the NetBackup for Sybase option. 

d. Enter q to quit selecting options. 
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A prompt appears asking if the list is correct. 

e. Answer y. 

The following actions occur: 

◆	 The version file, compressed tar file and install_dbext script are loaded to 
directory install_path/netbackup/dbext. 

◆ The install script automatically executes the install_dbext script. 

◆	 If the receiving client is configured as an HP-UX11.00, HP-UX11.11, Solaris7, 
Solaris8, or Solaris9, both the 32-bit and 64-bit versions of NetBackup for 
Sybase on UNIX will be installed. 

◆	 If install_dbext has successfully completed, there will be a version file in 
directory install_path/share that contains the version of NetBackup for 
Sybase on UNIX  that was installed and an installation timestamp. 

f. Enter q to quit from the script. 
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Compaq Tru64 Clients: Required Steps 

Note These instructions apply only for Compaq Tru64 clients. 

For NetBackup 5.1 for Sybase, Sybase ASE Backup Server must be started with special 
environment variables,  _RLD_ARGS=-taso and 
LD_LIBRARY_PATH=/usr/openv/lib. The NetBackup 4.5 for Sybase install script, 
install_sybackup, sets these environment variables in the Sybase ASE login scripts. 

For Sybase ASE 12.0, these login scripts are SYBASE.sh for the Bourne shell or 
SYBASE.csh for the C shell. 

For Sybase ASE 11.9.2, these login scripts are .profile for the Bourne shell or .cshrc 
for the C shell. 

All of these login scripts are located in the Sybase ASE home directory. 

The user must invoke one of these login scripts so that the user’s environment gets set up 
correctly before the Sybase ASE Backup Server is started. If the user’s environment is not 
set up correctly before Sybase ASE Backup Server is started, one of the following errors 
will be reported when a backup is attempted from NetBackup 4.5 for Sybase. 

Backup Server: 4.145.2.73: [0] Error for device 'sybackup::-SERV 

-SCHED Default-Application-Backup::00'. Pipe I/O returned 0 bytes 

Backup Server Internal Error: 4.62.3.4: Multibuffering 

subprocesses died, archive sybackup::-SERV -SCHED

Default-Application-Backup::00. Backup Server: 4.141.2.66: [0] The 

'write' call failed for device 'sybackup::-SERV -SCHED 

Default-Application-Backup::00' with error number 32 (Broken 

pipe). Refer to your operating system documentation for further

details.


Backup Server: 4.124.2.1: Archive API error for 

device='sybackup::-SERV -SCHED Default-Application-Backup::00':

Vendor application name=<UNINIT>, Library version=0, API 

routine=<UNINIT>, Message=Unable to open API library for device

'sybackup::-SERV -SCHED Default-Application-Backup'. Library path 

is '/db/sybase1200/ASE-12_0/lib/libsybackup.so'. dlopen()

returned: Code=22, Message=dlopen: cannot load

/db/sybase1200/ASE-12_0/lib/libsybackup.so


After installing or upgrading to NetBackup 4.5 for Sybase, the Sybase ASE Backup Server 
must be stopped and restarted with these environment variables to prevent this problem. 
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Specifying the Sybase Home Path 
After you install NetBackup for Sybase, perform this additional setup step that provides 
NetBackup for Sybase with information about your Sybase environment. NetBackup for 
Sybase provides a script to accomplish this setup. 

▼ To specify the Sybase home path 

1.	 Change to the following directory: 

/usr/openv/netbackup/bin 

2.	 Run the setup command: 

./sybase_config 

The following appears: 

Please specify the Sybase instance home path name:


3.	 Supply the appropriate home path name, and press Enter. 

The following appears: 

Do you have other Sybase instances? (y/n) [n] 


4.	 Add other Sybase instances as appropriate, or enter n if you are finished. 

The setup step is complete. 

Adding New Sybase Instances 
If you add a new Sybase instance after NetBackup for Sybase on UNIX has been installed, 
follow the procedure described in “Specifying the Sybase Home Path” on page 23. This 
ensures that all new database instances are included in the NetBackup for Sybase backup 
operations. 
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Before attempting to configure NetBackup for Sybase, complete the installation procedure 
as described in the Installation chapter. 

The following steps outline the configuration procedure. 

1. Configuring Media Using Media and Device Management 

2. Setting the Maximum Jobs Per Client Property 

3. Configuring a NetBackup Policy 

4. Creating Scripts 

5. Configuring the bp.conf File 

6. Enabling Striped Dumps and Loads 

7. Testing NetBackup for Sybase Configuration Settings 

To configure NetBackup for Sybase on UNIX from a Windows NetBackup server, see 
“Configuration Using the NetBackup Administration Console for Windows” on page 26. 

To configure NetBackup for Sybase on UNIX from a UNIX NetBackup server, see 
“Configuration Using the NetBackup Administration Console for UNIX” on page 42. 
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Configuration Using the NetBackup Administration  
Console for Windows 

Although the database agent is installed on the NetBackup client, some configuration 
procedures are performed using the NetBackup Administration Console on the server. 

These procedures include: 

◆ Configuring media using Media and Device Management 

◆ Setting the Maximum Jobs per Client property 

◆ Configuring a NetBackup policy 

◆ Testing NetBackup for Sybase configuration settings 

See the next section for instructions on starting the NetBackup Administration Console. 

▼ To launch the NetBackup Administration Console for Windows 

1. Log on to the server as administrator. 

2.	 Choose Start > Programs > VERITAS NetBackup > NetBackup Administration 
Console. 
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The NetBackup Administration Console is displayed. 

Configuring Media Using Media and Device Management 
Use the Media and Device Management (Media Manager) to configure media for a 
NetBackup for Sybase configuration. Refer to the NetBackup Media Manager System 
Administrator’s Guide for more information. 

The number of volumes required will depend on the devices used, the size of the Sybase 
databases that you are backing up, and the frequency of backups. 

Setting the Maximum Jobs Per Client Property 

The Maximum jobs per client attribute value is figured with the following formula. 

Maximum Jobs per Client = Number of Streams x Number of Policies 

Where: 

◆	 Number of Streams is the number of backup streams between the database server and 
NetBackup. Each separate stream starts a new backup job on the client. 
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◆	 Number of Policies is the number of policies that may back up this client at the same 
time. This number can be greater than one. For example, a client may be in two 
policies in order to back up two different databases. These backup windows may 
overlap. 

Tip	 To avoid any problems, we recommend that you enter a high enough value for the 
Maximum jobs per client property to meet the number of jobs executed by Sybase. 

▼ To set the Maximum jobs per client property using the Windows console 

1. In the left pane of the NetBackup Administration Console, expand Host Properties. 

2. Select Master Server. 

3.	 In the right pane, double-click on the server icon. 

The Master Server Properties dialog is displayed. 

4. In the Master Server Properties dialog, click Global Attributes. 

The default value is 1 for Maximum jobs per client. 

5. Change the Maximum jobs per client value to 99. 
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If you prefer to enter a lower value, calculate the value equal to the maximum number 
of backups allowed per client using the formula provided above. 

Configuring a NetBackup Policy 

A NetBackup policy defines the backup criteria for a specific group of one or more clients. 
These criteria include: 

◆ storage unit and media to use 

◆ backup schedules 

◆ clients to be backed up 

◆ script files to be executed on the clients 

To use NetBackup for Sybase, at least one Sybase policy with the appropriate schedules 
needs to be defined. A configuration can have a single policy that includes all clients or 
there can be many policies, some of which include only one client. 

Most requirements for Sybase policies are the same as for file system backups. In addition 
to the attributes described here, there are other attributes for a policy to consider. Refer to 
the NetBackup System Administrator’s Guide for Windows, Volume I or NetBackup System 
Administrator’s Guide for UNIX, Volume I for detailed configuration instructions and 
information on all the attributes available. 

Note	 If you are going to perform striped dumps or loads, also see “Enabling Striped 
Dumps and Loads” on page 68. 

Configuring a Sybase Policy 

Adding New Policies 

Use this procedure when configuring a policy from a Windows server or from a 
NetBackup Remote Administration Console host. 

▼ To add a new policy 

Note	 This policy name can be specified in the bp.conf file on the client. This policy 
name can also be specified in the $SYBASE_HOME/bp.conf file. Refer to 
“Configuring the bp.conf File” on page 66 for details. 
Also, this policy name can be specified in the Sybase backup script. Refer to 
“Instructions for Modifying Backup Scripts for Use with Sybase ASE” on page 60 
for more details. 
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1. Log on to the server as administrator. 

2. Start the NetBackup Administration Console. 

3.	 If your site has more than one master server, choose the one where you want to add 
the policy. 

4.	 In the left pane, right-click Policies and choose New Policy. 

The Add a New Policy dialog is displayed. 

a. In the Policy name box, type a unique name for the new policy. 

b.	 Choose whether to use the wizard for configuring the policy. The wizard guides 
you through most of the setup process and simplifies it by automatically choosing 
default values that are good for most configurations. If necessary, you can change 
the defaults later by editing the policy. You will need to manually add entries to 
the Backup Selections list after completing the wizard. 

◆	 To use the wizard, select the Use Backup Policy Configuration Wizard box 
and click OK. The wizard starts and you create the policy by following the 
prompts. When prompted, select the Sybase policy type. 

Note	 The Sybase policy type will not appear in the drop-down list unless your server has 
a license key for NetBackup for Sybase. 

◆	 If you require more control over the settings than the wizard provides, then 
do not select the Use Backup Policy Configuration Wizard box and proceed 
to step 5. 

5. Click OK. 
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A dialog is displayed in which you can specify the general attributes for the policy. 

6. From the Policy Type box, select the Sybase policy type. 

7.	 Complete the entries on the Attributes tab as explained in “Description of 
Attributes.” 

8. Add other policy information: 

◆ To add schedules, see “Adding New Schedules.” 

◆ To add clients, see “Adding Clients to a Policy.” 

◆	 To add scripts to the Backup Selections list, see “Specifying the List of Backup 
Selections.” 

9. Click OK. The new policy is created. 
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Description of Attributes 

With a few exceptions, NetBackup manages a database backup like a file system backup. 
Policy attributes that are different for Sybase backups are explained below. 

Your other policy attributes will vary according to your specific backup strategy and 
system configuration. Consult the NetBackup System Administrator’s Guide for Windows, 
Volume I or NetBackup System Administrator’s Guide for UNIX, Volume I for detailed 
explanations of the policy attributes. 

Description of Policy Attributes 

Attribute Description 

Policy type	 Determines the type of clients that can be in the policy and in some cases 
the types of backups that can be performed on those clients. 
To use NetBackup for Sybase, you must have defined at least one Sybase 
policy. 

Keyword phrase to For NetBackup for Sybase, the keyword phrase entry is ignored. 
associate with the 
backup 

Adding New Schedules 

Each policy has its own set of schedules. These schedules control initiation of automatic 
backups and also specify when user operations can be initiated. 

A Sybase backup requires an Application Backup schedule, which is created 
automatically when  you create a Sybase policy. The Application Backup schedule is used 
to initiate and manage the backup operation. You also need one or more Automatic 
Backup schedules, if you plan to have NetBackup perform automatic, scheduled backups. 

The following procedures explain how to configure the required schedule types, and how 
to add new schedules. The procedures start on the Policy dialog. To see the Policy dialog, 
double-click the policy name in the Policies list of the NetBackup Administration Console. 

▼ To configure an Application Backup schedule 

Note	 This Application Backup schedule name can be specified in the bp.conf file on the 
client. This Application Backup schedule name can also be specified in the 
$SYBASE_HOME/bp.conf file. Refer to “Configuring the bp.conf File” on page 66 
for details. Also, this Application Backup schedule name can be specified in the 
Sybase backup script. Refer to “Instructions for Modifying Backup Scripts for Use 
with Sybase ASE” on page 60 for more details. 
32 NetBackup for Sybase System Administrator’s Guide for UNIX 



Configuration Using the NetBackup Administration Console for Windows 
1. On the Policy dialog, click the Schedules tab. 

2. Double-click on the schedule named Default-Application-Backup. 

A dialog is displayed. 

All Sybase database operations are performed through NetBackup for Sybase using 
an Application Backup schedule. This includes those backups started automatically. 

You must configure an Application Backup schedule for each Sybase policy you 
create. If you do not do this, you will not be able to perform a  backup. To help satisfy 
this requirement, an Application Backup schedule named 
Default-Application-Backup is automatically created when you configure a new 
Sybase policy. 

3. Specify the other properties for the schedule as explained in “Schedule Properties.” 

The backup window for an Application Backup schedule must encompass the time 
period during which all NetBackup jobs, scheduled and unscheduled, will occur. This 
is necessary because the Application Backup schedule starts processes that are 
required for all NetBackup for Sybase backups, including those started automatically. 

For example, assume that you: 

◆	 expect users to perform NetBackup operations during business hours, 0800 to 
1300. 

◆ configured automatic backups to start between 1800 and 2200. 

The Application Backup schedule must have a start time of 0800 and a duration of 14 
hours. 

Example Settings for an Application Backup schedule 

Type of Backup Schedule settings Description Settings 

Application 
Backup 

Retention The length of time backup images 
are stored. 

2 weeks 

Backup Window The time during which a NetBackup 
operation can be performed. 

Sunday through Saturday 

00:00:01 - 23:59:59 

Tip	 Set the time period for the Application Backup schedule for 24 hours per day, seven 
days per week. This ensures that your NetBackup for Sybase operations are never 
locked out due to the Application Backup schedule. 
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▼ To configure an automatic backup schedule 

Note	 Generally, you will want to configure two Automatic Backup schedules for each 
Sybase ASE database; one for the database dump backups and one for the 
transaction log backups. 

1. On the Policy dialog, click the Schedules tab. 

2. Click New. 

A dialog is displayed. The title bar shows the name of the policy to which you are 
adding the schedules. 

3. Specify a unique name for the schedule. 

4. Select the Type of backup. 

For information on the types of backups available for this policy, see “Types of 
Backups.” 

Refer to the following table for example settings for an Automatic Backup schedule. 

Example Settings for an Automatic Backup Schedule 

Type of Backup Schedule settings Description Settings 

Automatic Backup Retention The length of time to store the 
record of a backup. 

2 weeks 
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Example Settings for an Automatic Backup Schedule 

Type of Backup Schedule settings Description Settings 

Frequency Frequency determines how often 
a backup should be performed 

every week 

Backup Window The time during which a 
NetBackup operation can be 
performed. 

Sunday, 18:00:00 - 22:00:00 

5. Specify the other properties for the schedule as explained in “Schedule Properties.” 

6. Click OK. 

Schedule Properties 

Some of the schedule properties have a different meaning for database backups than for a 
regular file system backup. These properties are explained in the following table. 

Other schedule properties vary according to your specific backup strategy and system 
configuration. Consult the NetBackup System Administrator’s Guide for Windows, Volume I or 
NetBackup System Administrator’s Guide for UNIX, Volume I for detailed explanations of the 
schedule properties. 

Description of Schedule Properties 

Property Description 

Type of backup	 Specifies the type of backup that this schedule will control. The selection list 
shows only the backup types that apply to the policy you are configuring. 

For more information see the following section “Types of Backups.” 

Frequency	 This setting is used only for scheduled backups, and not for user-directed 
backups. Frequency specifies the period of time that will elapse until the 
next backup operation can begin on this schedule. For example, if the 
frequency is seven days and a successful backup occurs on Wednesday, the 
next full backup will not occur until the following Wednesday. Normally, 
incremental backups will have a shorter frequency than full backups. 

Calendar	 This setting is used only for scheduled backups, and not for user-directed 
backups. The Calendar option allows you to schedule backup operations 
based on specific dates, recurring week days, or recurring days of the 
month. 
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Description of Schedule Properties (continued) 

Property Description 

Retention Frequency based scheduling 

The retention period for an Application Backup schedule refers to the 
length of time that NetBackup keeps backup images. 

The retention period for an Automatic Backup schedule controls how long 
NetBackup keeps records of when scheduled backups have occurred. 

The NetBackup scheduler compares the latest record to the frequency to 
determine whether a backup is due. This means that if you set the retention 
period to expire the record too early, the scheduled backup frequency will be 
unpredictable. However, if you set the retention period to be longer than 
necessary, the NetBackup catalog will accumulate unnecessary records. 
Therefore, set a retention period that is longer than the frequency setting for the 
schedule. 

For example, if the frequency setting is set to one week, set the retention 
period to be more than one week. 

Calendar based scheduling 

The retention period for an Application Backup schedule refers to the length 
of time that NetBackup keeps backup images. 

The retention period for an Automatic Backup schedule controls how long 
NetBackup keeps records of when scheduled backups have occurred. 
However, this setting is not significant for calendar based scheduling. 

Multiple copies	 If you are licensed for the Inline Tape Copy feature and wish to specify 
multiple copies for your Sybase policy, configure Multiple copies on the 
Application Backup schedule. 

Types of Backups 

Description of Backup Types for Sybase 

Application Backup	 The Application Backup schedule enables user-controlled NetBackup 
operations performed on the client. At least one Application Backup 
schedule type must be configured for each Sybase policy. The 
Default-Application-Backup schedule is automatically configured as an 
Application Backup schedule. 
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Description of Backup Types for Sybase 

Automatic Backup	 An Automatic Backup schedule specifies the dates and times when 
NetBackup will automatically start backups by running the Sybase backup 
scripts in the order that they appear in the file list. If there is more than one 
client in the Sybase policy, the Sybase backup scripts are executed on each 
client. 

Adding Clients to a Policy 

The client list is the list of clients on which your Sybase backup scripts are run during an 
automatic backup. A NetBackup client must be in at least one policy but can be in more 
than one. 

This procedure starts in the Policy dialog. To see the Policy dialog, double-click the policy 
name in the Policies list in the NetBackup Administration Console. 

Requirements for clients 

The following software must be installed on the client: 

◆ Sybase 

◆ NetBackup client or server 

◆ NetBackup for Sybase 

◆ the backup or restore script(s) 

▼ To add clients to a policy 

1. In the Policy dialog, click the Clients tab. 

2. Click New. 

3. Enter the name of the client you want to add. 

◆ Type the name into the client list and click OK. 

If NetBackup cannot detect the hardware and operating system, a dialog will be 
displayed so you can specify this information. 

OR 

◆ Click the Browse for Computer button to choose the client from the network: 

If Sybase is installed in a cluster, specify the virtual Sybase name as the client name. 
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4.	 To add another client, repeat step 2 and step 3. If this is the last client, click OK to 
close the dialog. 

Specifying the List of Backup Selections 

The Backup Selections list in a database policy has a different meaning than for 
non-database policies. For example, in a Standard policy, the list contains files and 
directories to be backed up. In a database policy, you specify scripts to be run. 

Add scripts only if you are setting up a policy for automatic scheduling. All scripts listed 
in the Backup Selections list will be executed for the Automatic Backup schedules, as 
specified under the Schedules tab, and manual backups. NetBackup will start backups 
according to the order that scripts appear in the Backup Selections list. 

The following procedure starts in the Policy dialog. To see the Policy dialog, double-click 
the policy name in the Policies list in the NetBackup Administration Console. 

▼ To add scripts to the Backup Selections list 

1. In the Policy dialog, click the Backup Selections tab. 

2. Click New. 

3. Enter the name of the selection. 

◆ Type the name of the script. 

Be sure to specify the full pathname when listing Sybase scripts. For example: 

install_path/netbackup/ext/dbext/sybase/scripts/script_name 

where script_name is the name of the Sybase backup script that the customer 
actually uses to back up the Sybase database. An example for Sybase ASE is 
sybase_mydb_backup, a sample script copied to the client during NetBackup 
for Sybase installation. 

Refer to “Instructions for Modifying Backup Scripts for Use with Sybase ASE” on 
page 60for more details on Sybase backup scripts. 

OR 

◆ Click the Remote Folder button. 

The Browse window is displayed. Navigate to the script file and select the file. 
Click OK. 

Be sure that the Sybase scripts listed here are installed on each client in the Client list. 

4. Click OK. 
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Example Sybase Policy for Sybase ASE on a NetBackup Windows  
Server 

The Sybase policy above is set up to use a separate volume pool named NetBackup. 
NetBackup uses he NetBackup volume pool to store all the images associated with Sybase 
backups. 

The client list names the client that has the database. 

The file list specifies the name of the Sybase backup script for the database and transaction 
log dumps. We created this script previously and named it: 

install_path/netbackup/ext/db_ext/sybase/scripts/sybase_mydb_backup


The three schedules for this policy are named: 

◆ database_dump 

◆ transaction_dump 

◆ Default-Application-Backup 

First, we set up the schedules named database_dump and transaction_dump. These are 
Automatic Backup schedules that execute automatically at the designated times. 

◆ database_dump 
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Executes once a week between 6 pm (18:00) on Friday night and 6 am (06:00) Saturday 
morning. When the sybase_mydb_backup script detects this schedule name, it starts a 
full backup of the database by performing a database dump. 

◆ transaction_dump 

Executes every night between 6 pm (18:00) and 6 am (06:00). When the 
sybase_mydb_backup script detects this schedule name, it starts a backup of the 
transaction logs by performing a transaction log dump. 

At this point, our configuration causes a Sybase database dump to occur every Friday 
night, and a transaction log dump to occur every night except Friday. 

The Application Backup schedule named Default-Application-Backup was created when 
the NetBackup Sybase policy was created. The backup window for this schedule 
encompasses the windows for the Automatic Backup schedules. It also includes the times 
user backups are allowed. To accomplish this, the user-directed window is open 24 hours 
a day, every day of the week. This permits scheduled backups and user directed backups 
to occur at any time. 
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Creating a Standard Policy 
A Standard policy is used to back up Sybase files: data files, shell scripts, Sybase SQL 
scripts and logs. In the following example, we identify scripts as Sybase files and create a 
NetBackup Standard policy with a User Backup schedule to back them up. Assume that 
we keep the Sybase files in the $SYBASE/syb_files directory. 

The following schedule permits a user-directed backup at any time. 
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Configuration Using the NetBackup Administration 
Console for UNIX 

Although the database agent is installed on the NetBackup client, some configuration 
procedures are performed using the NetBackup Administration Console on the server. 

These procedures include: 

◆ Configuring media using Media and Device Management 

◆ Setting the Maximum Jobs per Client property 

◆ Configuring a NetBackup policy 

◆ Testing NetBackup for Sybase configuration settings 

See the next section for instructions on starting the NetBackup Administration Console. 

▼ To launch the NetBackup Administration Console for UNIX 

1. Log onto the UNIX server as root. 

2.	 Start the NetBackup Administration Console by executing: 

install_path/netbackup/bin/jnbSA & 

The login dialog is displayed. 

3.	 Type the name of the master server where you initially want to manage NetBackup. 
You can specify any NetBackup master server. Indicate the User and Password. 
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4. Click Login. The NetBackup Administration Console is displayed. 

Configuring Media Using Media and Device Management 
Use the Media and Device Management (Media Manager) to configure media for a 
NetBackup for Sybase configuration. Refer to the NetBackup Media Manager System 
Administrator’s Guide for more information. 

The number of volumes required will depend on the devices used, the size of the Sybase 
databases that you are backing up, and the frequency of backups. 

Setting the Maximum Jobs Per Client Property 
The Maximum jobs per client attribute value is figured with the following formula. 

Maximum Jobs per Client = Number of Streams x Number of Policies 

Where: 

◆	 Number of Streams is the number of backup streams between the database server and 
NetBackup. Each separate stream starts a new backup job on the client. 
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◆	 Number of Policies is the number of policies that may back up this client at the same 
time. This number can be greater than one. For example, a client may be in two 
policies in order to back up two different databases. These backup windows may 
overlap. 

Tip	 To avoid any problems, we recommend that you enter a high enough value for the 
Maximum jobs per client property to meet the number of jobs executed by Sybase. 

▼	 To set the Maximum jobs per client property using the NetBackup Administration 
Console for UNIX 

1.	 In the left pane of the NetBackup Administration Console, expand Host Properties. 
Select Master Servers. 

2.	 In the right pane, double-click on the server icon. Click Global Attributes. 

The Master Server Properties dialog is displayed. 

The default value is 1 for Maximum jobs per client. 

3. Change the Maximum jobs per client value to 99. 
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If you prefer to enter a lower value, calculate the value equal to the maximum number 
of backups allowed per client using the formula provided above. 

▼ 

Configuring a NetBackup Policy 
A NetBackup policy defines the backup criteria for a specific group of one or more clients. 
These criteria include: 

◆ storage unit and media to use 

◆ backup schedules 

◆ clients to be backed up 

◆ script files to be executed on the clients 

To use NetBackup for Sybase, at least one Sybase policy with the appropriate schedules 
needs to be defined. A configuration can have a single policy that includes all clients or 
there can be many policies, some of which include only one client. 

Most requirements for Sybase policies are the same as for file system backups. In addition 
to the attributes described here, there are other attributes for a policy to consider. Refer to 
the NetBackup System Administrator’s Guide for Windows, Volume I or NetBackup System 
Administrator’s Guide for UNIX, Volume I for detailed configuration instructions and 
information on all the attributes available. 

Note	 If you are going to perform striped dumps or loads, also see “Enabling Striped 
Dumps and Loads” on page 68. 

Configuring a Sybase Policy 

Adding New Policies 

Use this procedure when configuring a policy from a UNIX server. 

▼ To add a new policy 

Note	 This policy name can be specified in the bp.conf file on the client. This policy 
name can also be specified in the $SYBASE_HOME/bp.conf file. Refer to 
“Configuring the bp.conf File” on page 66 for details. 
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Also, this policy name can be specified in the Sybase backup script. Refer to 
“Instructions for Modifying Backup Scripts for Use with Sybase ASE” on page 60 
for more details. 

1. Log onto the server as root. 

2. Start the NetBackup Administration Console. 

3.	 If your site has more than one master server, choose the one to which you want to add 
the policy. 

4.	 In the left pane, click on Policies. The right pane splits into an All Policies pane and a 
details pane. 

5.	 In the All Policies pane, right-click on the Master Server, and click New. 

The Add a New Policy dialog is displayed. 

a. In the Policy name box, type a unique name for the new policy. 

b.	 Choose whether to use the wizard for configuring the policy. The wizard guides 
you through most of the setup process and simplifies it by automatically choosing 
default values that are good for most configurations. If necessary, you can change 
the defaults later by editing the policy. You will need to manually add entries to 
the Backup Selections list after completing the wizard. 

◆	 To use the wizard, select the Use add policy wizard box and click OK. The 
wizard starts and you create the policy by following the prompts. When 
prompted, select the Sybase policy type. 

Note	 The Sybase policy type will not appear in the drop-down list unless your server has 
a license key for NetBackup for Sybase. 

◆	 If you require more control over the settings than the wizard provides, do not 
select the Use add policy wizard box and proceed to step 6. 

6. Click OK. 
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A dialog is displayed in which you can specify the general attributes for the policy. 

7. From the Policy type box, select the Sybase policy type. 

8.	 Complete the entries on the Attributes tab as explained in “Description of Attributes” 
and click Apply to save the attribute entries. 

9.	 Add other policy information: 

◆ To add schedules, see “Adding New Schedules.” 

◆ To add clients, see “Adding Clients to a Policy.” 

◆ To add scripts, see “Specifying the List of Backup Selections.” 

10. Click Apply. The new policy is created. 
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Description of Attributes 

With a few exceptions, NetBackup manages a database backup like a file system backup. 
Policy attributes that are different for Sybase backups are explained below. 

Your other policy attributes will vary according to your specific backup strategy and 
system configuration. Consult the NetBackup System Administrator’s Guide for Windows, 
Volume I or NetBackup System Administrator’s Guide for UNIX, Volume I for detailed 
explanations of the policy attributes. 

Description of Policy Attributes 

Attribute Description 

Policy type	 Determines the type of clients that can be in the policy and in some cases 
the types of backups that can be performed on those clients. 
To use NetBackup for Sybase, you must have defined at least one Sybase 
policy. 

Keyword phrase to For NetBackup for Sybase, the keyword phrase entry is ignored. 
associate with the 
backup 

Adding New Schedules 

Each policy has its own set of schedules. These schedules control initiation of automatic 
backups and also specify when user operations can be initiated. 

A Sybase backup requires at least two specific schedule types: an Application Backup 
schedule and an Automatic Backup schedule. You can also create additional schedules. 

The following procedures explain how to configure the required schedule types, and how 
to add other new schedules. The procedures start from the Policy dialog. To see the Policy 
dialog, double click the policy in the policy list in the left pane of the NetBackup 
Administration Console. 

▼ To configure an Application Backup schedule 

Note	 This Application Backup schedule name can be specified in the bp.conf file on the 
client. This Application Backup schedule name can also be specified in the 
$SYBASE_HOME/bp.conf file. Refer to “Configuring the bp.conf File” on page 66 
for details Also, this Application Backup schedule name can be specified in the 
Sybase backup script. Refer to “Instructions for Modifying Backup Scripts for Use 
with Sybase ASE” on page 60 for more details.. 
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1. In the Policy dialog, click the Schedules tab. 

2.	 In the Schedule list, double-click on the schedule named 
Default-Application-Backup. 

A dialog is displayed. The title bar shows the name of the policy to which you are 
adding the schedule. 

All Sybase database operations are performed through NetBackup for Sybase using 
an Application Backup schedule. This includes those backups started automatically. 

You must configure an Application Backup schedule for each Sybase policy you 
create. If you do not do this, you will not be able to perform a  backup. To help satisfy 
this requirement, an Application Backup schedule named Default-Application-Backup 
is automatically created when you configure a new Sybase policy. 

3. Specify the other properties for the schedule as explained in “Schedule Properties.” 

The backup window for an Application Backup schedule must encompass the time 
period during which all NetBackup jobs, scheduled and unscheduled, will occur. This 
is necessary because the Application Backup schedule starts processes that are 
required for all NetBackup for Sybase backups, including those started automatically. 

For example, assume that you: 

◆	 expect users to perform NetBackup operations during business hours, 0800 to 
1300. 

◆ configured automatic backups to start between 1800 and 2200. 

The Application Backup schedule must have a start time of 0800 and a duration of 14 
hours. 

Tip	 Set the time period for the Application Backup schedule for 24 hours per day, seven 
days per week. This ensures that your NetBackup for Sybase operations are never 
locked out due to the Application Backup schedule. 

Example Settings for an Application Backup schedule 

Type of Backup Schedule settings Description Settings 

Application 
Backup 

Retention The length of time backup images 
are stored. 

2 weeks 

Backup Window The time during which a NetBackup 
operation can be performed. 

Sunday through Saturday 

00:00:01 - 23:59:59 
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▼ To configure an automatic backup schedule 

Note	 Generally, you will want to configure two Automatic Backup schedules for each 
Sybase ASE database; one for the database dump backups and one for the 
transaction log backups. 

1. In the Policy dialog, click the Schedules tab. 

2. Click New. 

A dialog is displayed. The title bar shows the name of the policy to which you are 
adding the schedules. 

3. Specify a unique name for the schedule. 

4. Select the Type of Backup. 

For information on the types of backups available for this policy, see “Types of 
Backups.” 
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Refer to the following tables for example settings for an Automatic Backup schedule. 

Example Settings for a Automatic Backup Schedule 

Type of Backup Schedule settings Description Settings 

Automatic Backup Retention The length of time to store the 
record of a backup. 

2 weeks 

Frequency Frequency determines how often 
a backup should be performed 

every week 

Backup Window The time during which a 
NetBackup operation can be 
performed. 

Sunday, 18:00:00 - 22:00:00 

5. Specify the other properties for the schedule as explained in “Schedule Properties.” 

6. If this is the last schedule, click OK. 

Schedule Properties 

Some of the schedule properties have a different meaning for database backups than for a 
regular file system backup. These properties are explained in the following table. 

Other schedule properties vary according to your specific backup strategy and system 
configuration. Consult the NetBackup System Administrator’s Guide for Windows, Volume I or 
NetBackup System Administrator’s Guide for UNIX, Volume I for detailed explanations of the 
schedule properties. 

Description of Schedule Properties 

Property Description 

Type of backup	 Specifies the type of backup that this schedule will control. The selection list 
shows only the backup types that apply to the policy you are configuring. 

For more information see the following section “Types of Backups.” 

Frequency	 This setting is used only for scheduled backups, and not for user-directed 
backups. Frequency specifies the period of time that will elapse until the 
next backup operation can begin on this schedule. For example, if the 
frequency is seven days and a successful backup occurs on Wednesday, the 
next full backup will not occur until the following Wednesday. Normally, 
incremental backups will have a shorter frequency than full backups. 
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Description of Schedule Properties (continued) 

Property Description 

Calendar	 This setting is used only for scheduled backups, and not for user-directed 
backups. The Calendar option allows you to schedule backup operations 
based on specific dates, recurring week days, or recurring days of the 
month. 

Retention Frequency based scheduling 

The retention period for an Application Backup schedule refers to the 
length of time that NetBackup keeps backup images. 

The retention period for an Automatic Backup schedule controls how long 
NetBackup keeps records of when scheduled backups have occurred. 

The NetBackup scheduler compares the latest record to the frequency to 
determine whether a backup is due. This means that if you set the retention 
period to expire the record too early, the scheduled backup frequency will be 
unpredictable. However, if you set the retention period to be longer than 
necessary, the NetBackup catalog will accumulate unnecessary records. 
Therefore, set a retention period that is longer than the frequency setting for the 
schedule. 

For example, if the frequency setting is set to one week, set the retention 
period to be more than one week. 

Calendar based scheduling 

The retention period for an Application Backup schedule refers to the length 
of time that NetBackup keeps backup images. 

The retention period for an Automatic Backup schedule controls how long 
NetBackup keeps records of when scheduled backups have occurred. 
However, this setting is not significant for calendar based scheduling. 

Multiple copies	 If you are licensed for the Inline Tape Copy feature and wish to specify 
multiple copies for your Sybase policy, configure Multiple copies on the 
Application Backup schedule. 
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Types of Backups 

Description of Backup Types for Sybase 

Application Backup	 The Application Backup schedule enables user-controlled NetBackup 
operations performed on the client. At least one Application Backup 
schedule type must be configured for each Sybase policy. The 
Default-Application-Backup schedule is automatically configured as an 
Application Backup schedule. 

Automatic Backup	 An Automatic Backup schedule specifies the dates and times when 
NetBackup will automatically start backups by running the Sybase backup 
scripts in the order that they appear in the file list. If there is more than one 
client in the Sybase policy, the Sybase backup scripts are executed on each 
client. 

Adding Clients to a Policy 

The client list is the list of clients on which your NetBackup for Sybase backups will be 
performed. A NetBackup client must be in at least one policy but can be in more than one. 

This procedure starts from the Policy dialog. To see the Policy dialog, double-click the 
policy in the policy list in the left pane of the NetBackup Administration Console. 

Requirements for clients 

The following software must be installed on the client: 

◆ Sybase 

◆ NetBackup for Sybase


◆ the backup and restore Sybase script(s)


▼ To add clients to a policy 

1. In the Policy dialog, click the Clients tab. 

2. On the Clients tab, click New. 
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The Add Client dialog is displayed. The title bar shows the name of the policy where 
you are adding clients. 

3.	 In the Client name text box, type the name of the client that you are adding. 

If Sybase is installed in a cluster, specify the virtual Sybase name as the client name. 

4. Choose the Hardware and operating system type and click Add. 

5.	 If this is the last client, click OK. If you are going to add more clients, repeat step 3 and 
step 4. 

Specifying the List of Backup Selections 

The Backup Selections list in a database policy has a different meaning than for 
non-database policies. For example, in a Standard policy, the list contains files and 
directories to be backed up. In a database policy, the list contains script. 

Add scripts only if you are setting up a policy for automatic scheduling. All scripts listed 
in the Backup Selections list will be executed for the Automatic Backup schedules as 
specified under the Schedules tab. NetBackup will start backups by running the scripts in 
the order that they appear in the Backup Selections list. 

The following procedure starts from the Policy dialog. To see the Policy dialog, 
double-click the policy in the Policies list in the NetBackup Administration Console. 

▼ To add scripts to the Backup Selections List 

1. In the Policy dialog, click the Backup Selections tab. 

2. Click New. 
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A dialog is displayed. The title bar shows the name of the policy to which you are 
adding the scripts. 

3.	 Type the name of the Sybase script. 

Be sure to specify the full pathname when listing Sybase scripts. For example: 

install_path/netbackup/ext/dbext/sybase/scripts/script_name 

where script_name is the name of the Sybase backup script that the customer 
actually uses to back up the Sybase database. An example for Sybase ASE is 
sybase_mydb_backup, a sample script copied to the client during NetBackup for 
Sybase installation. 

Refer to “Instructions for Modifying Backup Scripts for Use with Sybase ASE” on 
page 60 for more details on Sybase backup scripts. 

Be sure that the Sybase scripts listed here are installed on each client in the Client list. 

4. Click Add. 

5. To add more scripts, repeat step 3 and step 4. 

6. When you are finished adding backup selections, click OK. 
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Example Sybase Policy for Sybase on a NetBackup UNIX Server 

The Sybase policy above is set up to use a separate volume pool named NetBackup. 
NetBackup uses he NetBackup volume pool to store all the images associated with Sybase 
backups. 

The client list names the client that has the database. 
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The file list specifies the name of the Sybase backup script for the database and transaction 
log dumps. We created this script previously and named it: 

install_path/netbackup/ext/db_ext/sybase/scripts/sybase_mydb_backup


The three schedules for this policy are named: 

◆ database_dump 

◆ transaction_dump 

◆ Default-Application-Backup 

First, we set up the schedules named database_dump and transaction_dump. These are 
Automatic Backup schedules that execute automatically at the designated times. 

◆ database_dump 

Executes once a week between 6 pm (18:00) on Friday night and 6 am (06:00) Saturday 
morning. When the sybase_mydb_backup script detects this schedule name, it starts a 
full backup of the database by performing a database dump. 

◆ transaction_dump 

Executes every night between 6 pm (18:00) and 6 am (06:00). When the 
sybase_mydb_backup script detects this schedule name, it starts a backup of the 
transaction logs by performing a transaction log dump. 

At this point, our configuration causes a Sybase database dump to occur every Friday 
night, and a transaction log dump to occur every night except Friday. 

The Application Backup schedule named Default-Application-Backup was created when 
the NetBackup Sybase policy was created. The backup window for this schedule 
encompasses the windows for the Automatic Backup schedules. It also includes the times 
user backups are allowed. To accomplish this, the user-directed window is open 24 hours 
a day, every day of the week. This permits scheduled backups and user directed backups 
to occur at any time. 
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Creating a Standard Policy 
A Standard policy is used to back up Sybase files: data files, shell scripts, Sybase SQL 
scripts and logs. In the following example, we identify scripts as Sybase files and create a 
NetBackup Standard policy with a User Backup schedule to back them up. Assume that 
we keep the Sybase files in the $SYBASE/syb_files directory. 

The following schedule permits a user-directed backup at any time. 
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Creating Scripts 
Sybase SQL scripts cause SQL Server to send the directives to Sybase ASE Backup Server 
that initiate a dump or load of the specified database or transaction log. The Sybase isql 
utility communicates with SQL server. See the SYBASE SQL Server Utility Programs for 
UNIXmanual for information about the isql utility. (This manual is available from 
Sybase.) 

The following example scripts are included with the NetBackup for Sybase installation for 
use with Sybase ASE: 

sybase_mydb_backup

sybase_mydb_load

sybase_mydb_restore


These scripts are installed in the following directory: 

install_path/netbackup/ext/db_ext/sybase/scripts/


Be sure to modify these scripts for your environment. 

Note	 If necessary, copy the example scripts to a different directory on your client. Sybase 
backup scripts can be located anywhere on the client. 

Although each script can have multiple Sybase ASE Backup Server operations, a separate 
script is required for each type of operation. For example, separate scripts for backups and 
restores are required. 

Caution	 Always specify the correct script when configuring automatic backups or when 
starting operations through NetBackup. NetBackup for Sybase does not 
generate an error if a restore script is used for a backup operation or a backup 
script is used for a restore operation. 
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Instructions for Modifying Backup Scripts for Use with Sybase 
ASE 

1.	 If necessary, copy the example scripts to a different directory on your client. Sybase 
backup scripts can be located anywhere on the client. 

2.	 Set the access permissions of these scripts to 775. 

chmod 775 script_name 

3. Modify the sybase_mydb_backup script. 

a.	 Use a text editor to open the sybase_mydb_backup script. 

The following example uses the vi text editor. 

vi sybase_mydb_backup 

The following appears. 

1. 

#***************************************************************************

# Replace /usr/sybase12 below with the actual Sybase home directory 

#***************************************************************************

SYBASE=/usr/sybase12


#***************************************************************************

# Replace SYBASE12 below with the actual name of the SQL Server

#***************************************************************************

SYBSERVER=SYBASE12


#***************************************************************************

# Replace SYB_DB below with the actual name of your Sybase database

#***************************************************************************

DATABASE_NAME=SYB_DB


#***************************************************************************

# Replace syb_files below with your actual name of the NetBackup 

# server Policy to be used to backup the directory with Sybase script files

#***************************************************************************

SYB_FILES_POLICY=syb_files


#***************************************************************************

# Replace /usr/sybase12/scripts below with your actual path of the Sybase files 

#***************************************************************************

SYB_FILES_DIR=/usr/sybase12/scripts


if [ ! -d "${SYBASE}"/ASE-12_0/ ]

then
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#************** Sybase 11.9.2 or earlier *******************

ASE_QUAL=

OCS_QUAL=

else

#************** Sybase 12.0 ****************************

SYBASE_ASE=ASE-12_0; export SYBASE_ASE

SYBASE_OCS=OCS-12_0; export SYBASE_OCS

ASE_QUAL=/$SYBASE_ASE

OCS_QUAL=/$SYBASE_OCS

fi


echo "Started `date`"

SYBASE=$SYBASE; export SYBASE

# These environment variables are set by NetBackup 

echo "SYBACKUP_SERVER = $SYBACKUP_SERVER"

echo "SYBACKUP_POLICY = $SYBACKUP_POLICY"

echo "SYBACKUP_SCHED = $SYBACKUP_SCHED"

echo "SYBACKUP_SCHEDULED = $SYBACKUP_SCHEDULED"

echo "SYBACKUP_USER_INITIATED = $SYBACKUP_USER_INITIATED"


RETURN_STATUS=0


#***************************************************************************

# Replace "database_dump" below with your actual NetBackup schedule name

# which is used for a full backup of the Sybase database.

#***************************************************************************

if [ "${SYBACKUP_SCHED}" = "database_dump" ]

then

############# NetBackup has started a "database_dump" backup ##############

DUMP_TYPE=DATABASE


else

############# NetBackup has started a "transaction log" backup ##############

DUMP_TYPE=TRANSACTION

fi


#***************************************************************************

# Replace "Default-Application-Backup" below with your actual NetBackup 

# Application Backup type schedule name for the Sybase database. 

#***************************************************************************

echo dump $DUMP_TYPE $DATABASE_NAME to \"sybackup::-SERV $SYBACKUP_SERVER -POL 


$SYBACKUP_POLICY -SCHED Default-Application-Backup\" > ./syb_${DATABASE_NAME}_dump


#**************************************************************************

# Remove the '#' from the beginning of the line below if you are going to

# use multiple stripes for the backup. Repeat this line for each stripe.

# Replace "Default-Application-Backup" below with your actual NetBackup

# Application Backup type schedule name for the Sybase database.

# **************************************************************************

# echo stripe on \"sybackup::-SERV $SYBACKUP_SERVER -POL $SYBACKUP_POLICY -SCHED 

Default-Application-Backup\" >> ./syb_${DATABASE_NAME}_dump 


echo go >> ./syb_${DATABASE_NAME}_dump
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#***************************************************************************

# Replace "manager" with your Sybase server Administrator's Password

#***************************************************************************

echo "$SYBASE$OCS_QUAL/bin/isql -Usa -Pmanager -I$SYBASE/interfaces -S$SYBSERVER < 


./syb_${DATABASE_NAME}_dump"


$SYBASE$OCS_QUAL/bin/isql -Usa -Pmanager -I$SYBASE/interfaces -S$SYBSERVER < 

./syb_${DATABASE_NAME}_dump

RETURN_STATUS=$?


if [ "${DUMP_TYPE}" = "DATABASE" ]

then

# Initiate a backup of any file related to the Sybase database, such as script files.


echo "bpbackup -c $SYB_FILES_POLICY $SYB_FILES_DIR"

/usr/openv/netbackup/bin/bpbackup -c $SYB_FILES_POLICY $SYB_FILES_DIR

BPBACKUP_STATUS=$?


if [ "$BPBACKUP_STATUS" -ne 0 ]

then

echo ""

echo "bpbackup of $SYB_FILES_DIR returned $BPBACKUP_STATUS"


fi

fi


echo "Finished `date`"


echo "exit $RETURN_STATUS"

echo ""


exit $RETURN_STATUS


b.	 Follow the instructions in the sybase_mydb_backup script. 

When customizing this script for backups, note the following lines: 

# Replace "database_dump" below with your actual schedule name

if [ "${SYBACKUP_SCHED}" = "database_dump" ]


The schedule name must be the same as the Automatic Backup schedule name 
used when setting up the NetBackup configuration in “Configuring a NetBackup 
Policy” on page 29. 

2.	 Test the scripts you just created. Refer to “Testing NetBackup for Sybase 
Configuration Settings” on page 70. 
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Instructions for Modifying Restore Scripts for Use with Sybase 
ASE 

1.	 If necessary, copy the example scripts to a different directory on your client. Sybase 
backup scripts can be located anywhere on the client. 

2.	 Set the access permissions of these scripts to 775. 

chmod 775 script_name 

3. Modify the sybase_mydb_restore script. 

a.	 Use a text editor to open the sybase_mydb_restore script. 

The following example uses the vi text editor. 

vi sybase_mydb_backup 

The following appears: 

#***************************************************************************

# Replace /usr/sybase12 below with your actual Sybase home directory 

#***************************************************************************

SYBASE=/usr/sybase12


#***************************************************************************

# Replace SYBASE12 below with your actual name of the SQL Server

#***************************************************************************

SYBSERVER=SYBASE12


if [ ! -d "${SYBASE}"/ASE-12_0/ ]

then

#************** Sybase 11.9.2 or earlier **************

ASE_QUAL=

OCS_QUAL=

else

#************** Sybase 12.0 or later **************

SYBASE_ASE=ASE-12_0; export SYBASE_ASE

SYBASE_OCS=OCS-12_0; export SYBASE_OCS

ASE_QUAL=/$SYBASE_ASE

OCS_QUAL=/$SYBASE_OCS

fi


#***************************************************************************

# Replace /usr/openv/netbackup/ext/db_ext/sybase/scripts/sybase_mydb_load

# below with your actual SQL script path which contains corresponding

# LOAD commands

#***************************************************************************

LOADDB=/usr/openv/netbackup/ext/db_ext/sybase/scripts/sybase_mydb_load


echo "Started `date`"
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SYBASE=$SYBASE; export SYBASE


RETURN_STATUS=0


# NetBackup has started a restore


#***************************************************************************

# Replace "manager" with your Sybase server Administrator's Password

#***************************************************************************

echo "$SYBASE$OCS_QUAL/bin/isql -Usa -Pmanager -I$SYBASE/interfaces -S$SYBSERVER < $LOADDB"

$SYBASE$OCS_QUAL/bin/isql -Usa -Pmanager -I$SYBASE/interfaces -S$SYBSERVER < $LOADDB


RETURN_STATUS=$?


echo "Finished `date`"


echo "exit $RETURN_STATUS"

echo ""


exit $RETURN_STATUS


b. Follow the instructions in the sybase_mydb_restore script. 

4. Modify the sybase_mydb_load script. 

load database mydb from "sybackup::SYBASE12.mydb.D.0.24312.20-12-2001.23:05:25"

go

load transaction mydb from "sybackup::SYBASE12.mydb.T.0.44532.21-12-2001.22:01:00"

go

load transaction mydb from "sybackup::SYBASE12.mydb.T.0.14142.22-12-2001.20:45:00"

go

online database mydb


Replace mydb with the name of the database. 

Replace the file name with the name obtained from the bplist command. Refer to 
“Browsing Backups” on page 79 for information about how to obtain the file name. 
The file name portion of the LOAD command begins after ::. Refer to the technical 
overview in “NetBackup for Sybase on UNIX” on page 7 for more information about 
the format of the file name. 

You can specify the NetBackup server on the device string of the LOAD command as 
shown in the following example. 

load database mydb from "sybackup::SYBASE12.mydb.D.0.24312.20-12-2001.23:05:25 -SERV saturn"

go

online database mydb

go
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The -SERV option overrides any server that is specified in the bp.conf file. 

5.	 Test the scripts you modified. Refer to “Testing NetBackup for Sybase Configuration 
Settings” on page 70 . 

Environment Variables 
When a schedule runs, NetBackup sets environment variables for the scripts to use when 
performing the backup. These environment variables are as follows: 

SYBACKUP_SERVER 

SYBACKUP_POLICY 

SYBACKUP_SCHED 

SYBACKUP_SCHEDULED 

SYBACKUP_USER_INITIATED 

Name of the NetBackup server. 

Name of the NetBackup policy. 

Name of the Automatic Backup schedule. 

Set to 1 if this is a scheduled backup (Automatic 
Backup). 

Set to 1 if this is a user-initiated backup 
(Application Backup backup). 

Note	 The SYBACKUP_POLICY and SYBACKUP_SCHED variables are set up only if the 
backup is initiated from the server (either automatically by the NetBackup 
scheduler or manually through the administrator interface). 
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Configuring the bp.conf File 
When a NetBackup for Sybase operation is initiated, NetBackup will search the 
configuration files for the POLICY, SERVER and SCHEDULE definitions in the following 
order. 

1. $SYBASE/bp.conf 

2. install_path/netbackup/bp.conf 

Note	 NetBackup uses a Policy or Schedule configured in the NetBackup Client 
Configuration for all backups on the client, including file system and Sybase 
database backups. For this reason, if a non-Sybase type Policy or Schedule is 
configured in the NetBackup Client Configuration, the -POLICY or -SCHED option 
must be used on the Sybase ASE DUMP command to specify the correct Policy or 
Schedule. Refer to “Instructions for Modifying Backup Scripts for Use with Sybase 
ASE” on page 60 for details on how to specify a Policy or Schedule on the Sybase 
ASE DUMP command. 

If NetBackup fails to find POLICY and SCHEDULE definitions, NetBackup for Sybase 
defaults to the first POLICY and SCHEDULE with the appropriate policy type. 

Create a $SYBASE/bp.conf File On the Client 
By configuring these bp.conf options, you ensure that NetBackup for Sybase will use the 
correct Sybase policy and schedule for your Sybase backups. 

1.	 Create a bp.conf file in your Sybase home directory. For example, if $SYBASE is 
/sybase, you will create the following file: 

/sybase/bp.conf


2. Add the following options to bp.conf file. 

BPBACKUP_POLICY=policy_name

BPBACKUP_SCHED=schedule_name


Where: 

policy_name is the name of the Sybase policy you want to use. 

schedule_name is the name of the Application Backup schedule that you want to use. 

Note NetBackup uses the $SYBASE/bp.conf file only for Sybase policies. 
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Options for /usr/openv/netbackup/bp.conf File On the Client 
Add a SYBASE_HOME option to the /usr/openv/netbackup/bp.conf file on the 
client. SYBASE_HOME must be your Sybase SQL Server home directory. For example, if 
$SYBASE_HOME is equal to /sybase, add the following to the bp.conf file. 

SYBASE_HOME=/sybase
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Enabling Striped Dumps and Loads 
NetBackup for Sybase supports the Sybase ASE Backup Server ability to open multiple 
streams simultaneously to perform parallel dumps and loads. ALL streams must be 
simultaneously available before the dump or load can proceed. In addition, the number of 
stripes specified during a load should match that of the dump. 

Caution	 NetBackup tape duplication must be performed with the multiplex option 
when Sybase ASE striping and NetBackup multiplex (MPX) is used for a Sybase 
ASE backup. The problem occurs when multiple Sybase ASE stripes are 
multiplexed to a single tape and then the tape is duplicated without using the 
-mpx option. The duplicated tape must be created with the -mpx option on the 
bpduplicate command (accessible as the Preserve multiplexing checkbox on 
the Duplicate Backup Images window). In addition, all of the backups from the 
original Sybase ASE multiplexing session must be included in the duplicated 
multiplexed group. 

If multiplexing striped Sybase ASE database backups, you may require a special 
configuration to restore them. By default, when restoring from multiplexed backups, 
NetBackup uses twelve data buffers. This is enough unless you are using more than 
twelve stripes. If you are using more than twelve stripes, increase the number of data 
buffers used by NetBackup as follows. 

1. Create the following file on the NetBackup master that has the storage unit. 

For a UNIX master server, enter the following: 

install_path/netbackup/db/config/NUMBER_DATA_BUFFERS_RESTORE 

For a Windows master server, enter the following: 

install_path\NetBackup\db\config\NUMBER_DATA_BUFFERS_RESTORE 

2. Specify the number of buffers. This number is the only entry in the file. 

Example Sybase SQL script for a Striped Dump for Sybase ASE 

dump database mydb to "sybackup::"

stripe on "sybackup::"

stripe on "sybackup::"

go


Note	 Refer to “Instructions for Modifying Backup Scripts for Use with Sybase ASE” on 
page 60 for further details. 

\ 
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Example Sybase SQL script for a Striped Load for Sybase ASE 

load database mydb from

"sybackup::SYBASE11.mydb.D.0.27997.20-10-1997.10:55:52"

stripe on "sybackup::SYBASE11.mydb.D.1.27999.20-10-1997.10:55:52"

stripe on "sybackup::SYBASE11.mydb.D.2.28001.20-10-1997.10:55:52"

go


Note	 Refer to “Instructions for Modifying Restore Scripts for Use with Sybase ASE” on 
page 63 for further details. 
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Testing NetBackup for Sybase Configuration Settings 
After configuring the master server for NetBackup for Sybase, test the configuration 
settings. For a description of status codes, refer to the NetBackup Troubleshooting Guide for 
UNIX and Windows. 

NetBackup Administration Console for Windows 
Use this procedure to test a policy configuration from a Windows server or from the 
Remote Administration Console. 

▼ To test the configuration settings on a Windows server 

1. Log onto the server as administrator. 

2. Start the NetBackup Administration Console. 

3. In the left pane, click Policies. The policy list appears in the right pane. 

4. Click on the policy you wish to test. 

5.	 Choose Actions > Manual Backup. 

The Manual Backup dialog is displayed. 

The Schedules pane contains the name of a schedule (or schedules) configured for the 
policy you are going to test. The Clients pane contains the name of the client(s) listed 
in the policy you are going to test. 

6. Follow the instructions on the dialog. 
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7. Click Activity Monitor on the NetBackup Administration Console. 

If the manual backup does not exit with a successful status, refer to the 
Troubleshooting chapter. 

NetBackup Administration Console for UNIX 
Use this procedure to test a policy configuration on the NetBackup Administration 
Console for UNIX. 

▼ To test the configuration settings on a UNIX server 

1. Log onto the server as root. 

2. Start the NetBackup Administration Console. 

3.	 In the left pane, click Policies. 

The right pane splits into an All Policies pane and a details pane. 

4. In the All Policies pane, click the policy you wish to test. 

5. Choose Actions > Manual Backup. 
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The Manual Backup dialog is displayed. 

The Schedules pane contains the name of a schedule (or schedules) configured for the 
policy you are going to test. The Clients pane contains the name of the client(s) listed 
in the policy you are going to test. 

6. Follow the instructions on the dialog. 

7. Click Activity Monitor on the NetBackup Administration Console. 
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If the manual backup does not exit with a successful status, refer to the 
Troubleshooting chapter. 
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Using NetBackup for Sybase on UNIX 
4 

After completing the installation and configuration, you can use the NetBackup interfaces 
to start Sybase backups and restores. You can also execute DUMP and LOAD commands 
directly from the isql utility to perform Sybase ASE backups and restores. 

Caution	 Always specify the correct Sybase backup script when configuring automatic 
backups or when starting operations through NetBackup. NetBackup for 
Sybase on UNIX will not generate an error if a restore Sybase backup script file 
is used for a backup operation or a backup Sybase backup script is used for a 
restore operation. 

This chapter contains the following sections: 

◆ Performing a Backup 

◆ Browsing Backups 

◆ Performing a Restore 
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Performing a Backup 
There are two types of Sybase ASE backups: full and incremental. 

◆	 full backup: A copy of the entire database, including both the data and transaction log. 
This is accomplished by performing a database dump. 

◆	 incremental backup :A copy of the transaction log that contains the database changes 
made since the last database or transaction log dump. You can run a transaction log 
dump only if the database stores its log on a separate segment. 

To ensure consistent and accurate backups, always use the DBCC command to check 
database consistency before backing up a database. The DUMP command can complete 
successfully even if your database is corrupt. 

Backup Strategy 

Note	 This backup strategy is an example. For guidelines on developing your own backup 
and recovery plan, refer to the SYBASE SQL Server System Administration Guide. 

One of the major tasks in developing a backup plan is to determine how often to back up 
your databases. The frequency of your backups determines how much work you can save 
in the event of a media failure. Dump each database just after you create it to provide a 
base point, and then dump it on a fixed schedule thereafter. 

An example database backup strategy follows: 

1. Perform a full-database backup by running a database dump every Friday night. 

2.	 Back up your important Sybase files every Friday night at the same time as the 
full-database backup. If desired, you can schedule additional backups for them at 
other times. See “Creating a Standard Policy” on page 41 . 

3. Perform an incremental backup each night by running a transaction log dump. 

4.	 For further protection, Sybase recommends that you save all the important Sybase 
scripts. This includes scripts that contain the disk init, create database, and 
alter database commands. 

5.	 Sybase also recommends that you save a hard copy of your sysdatabases, sysusages, 
and sysdevices tables each time you issue one of these commands. In addition, keep a 
copy of the syslogins and so on. 
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Automatic Backup of a Sybase Policy 
The most convenient way to back up your database is to set up schedules for automatic 
backups. When the NetBackup scheduler invokes a schedule for an automatic backup, the 
Sybase backup scripts run: 

◆ in the same order as they appear in the file list 

◆ on all clients that have them (that is, matching path names) 

The Sybase backup scripts start the database backup. 

Manual Backup of a Sybase Policy 
The administrator on the master server can use the NetBackup server software to 
manually execute an Automatic Backup schedule for the Sybase policy. Refer to 
“Configuring a NetBackup Policy” on page 29 for detailed instructions on configuring an 
automatic backup. 

Refer to “Testing NetBackup for Sybase Configuration Settings” on page 70 for 
instructions on initiating a backup of a Sybase policy. 

User-Directed Backup 

Using xbp to Perform a Backup 

Note xbp is not supported on AIX platforms. 

The following describes how to use xbp to back up your database. Refer to the xbp man 
page and the online help in the interface for detailed instructions on using xbp to back up 
the database. 

▼ To perform a backup using xbp 

1. Log in as the Sybase administrator or as root. 

If you are already logged in under a different user account, use the su - command to 
change to the Sybase administrator. 

2.	 Execute xbp on the client to which you want to backup a database. 

install_path/netbackup/bin/xbp 
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3.	 In the Directory to Search Box, type the path name of the location of the Sybase 
backup scripts. For example: 

install_path/netbackup/ext/db_ext/sybase/scripts/


4. Choose File > Browse File System for Sybase Backup Scripts. 

5. Select the backup script from the Files pane. 

6.	 Choose Backup > Backup Database Using Selected Scripts. The xbp_confirm dialog 
displays. 

7.	 Click OK. 

A NetBackup process called bphdb starts the Sybase backup script on the client. 

8. View the status of the script execution. 

a.	 Choose Backup > Report Progress Of Backup.... 

The xbp_progress dialog displays. 

b. Select the log file for your backup. 

The Contents of Selected Log File pane displays only the status of the script 
execution. A status =0 message indicates that the script was successfully 
completed. Go to Step 9 for a detailed status report. For a status other than 0, refer 
to the Troubleshooting section of this manual. For additional information, check 
the output of the script. 

9. View the log file for the NetBackup operation. 

a.	 Change directories to the bphdb log directory. 

cd install_path/netbackup/logs/bphdb 

b. Open the log file with the tail option. 

tail -f log.mmddyy


A Backup completed SUCCESSFULLY message indicates a successfully completed 
NetBackup operation. 

Using isql to Perform a Backup of a Sybase ASE Database 

You can start a backup by executing the Sybase ASE DUMP command from the isql utility 
on the client. For example: 
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dump transaction mydb to "sybackup::"

go


Note	 Refer to “Instructions for Modifying Backup Scripts for Use with Sybase ASE” on 
page 60 for further details. 

See the SYBASE SQL Server System Administration Guide for details on using the isql 
utility. 

Browsing Backups 

Using xbp to Browse 

Note xbp is not supported on AIX platforms. 

The following describes how to use xbp to browse your database backups. Refer to the 
xbp man page and the online help in the interface for detailed instructions on using xbp to 
browse database backups. 

1. Log in as the Sybase administrator or as root. 

If a different user account is used, use the su command to change to the Sybase 
administrator. 

2.	 Execute xbp on the client. 

install_path/netbackup/bin/xbp 

The xbp dialog is displayed. 

3.	 From the File menu, click Configuration. 

The xbp_config dialog displays. 

a. In the Policy type of image to browse, specify the Sybase policy. 

b. Click OK to close the dialog. 

c. In the Directory To Search Box, enter / as the directory to search. 

d. Set the Range of Dates to include the date of your backup. 

e. Enter 9 in the Directory Depth Box. 
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f.	 From the File menu, select Browse Backups (Restore). A list of backup images 
appears in the dialog. 

Using bplist to Browse 
You can use the bplist command to browse Sybase backup history on the master server. 
The result is the list of dump-file names. The following example uses bplist to search all 
Sybase backups (dumps) for a client (-C) named saturn on a server (-S) named candytuft. 

The -t 7 on this command specifies the Sybase backups (dumps). The -R on this 
command specifies recursive listing. 

Refer to the bplist(1M) man page for more information on this command. 

Note	 NetBackup stores Sybase backups (dumps) in its catalog as dumpfile, but when you 
specify a backup for the LOAD command, you must use dumpfile without the slash /. 
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Performing a Restore 
The procedure for restoring a Sybase database depends on the database involved and the 
problems that you have on your system. If the database and the device were lost: 

1. Initialize a new device. 

2. Re-create the database. 

See the SYBASE SQL Server System Administration Guide for a complete description of how 
to restore your database for each type of problem. 

The following example shows how to restore our example database, mydb, to the level of 
a recent database dump plus two transaction log dumps. 

1.	 Execute the LOAD commands directly from SQL Server. 

This loads the database dump and transaction log dumps. 

2. Check database consistency. 

When you have brought the database up-to-date, use DBCC commands to check the 
consistency of the database. 

Using xbp to Restore 
Before using xbp to perform a restore of a Sybase ASE database, the sybase_mydb_load 
script must be edited to contain the correct database name and dump-file name. A list of 
the dump-file names can be obtained by executing the bplist command. Refer to “Using 
bplist to Browse” on page 80. 

The following describes how to use xbp to restore your database. Refer to the xbp man 
page and the online help in the interface for detailed instructions on using xbp to restore 
database backups. 

▼ To use xbp to perform a restore 

1. Log in as the Sybase administrator or as root. 

If a different user account is used, change the su- command to the Sybase 
administrator. 

2.	 Execute xbp on the client to which you want to restore a database. 

install_path/netbackup/bin/xbp 
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3.	 In the Directory to Search Box, type in the path name of the location of the Sybase 
backup scripts. For example: 

install_path/netbackup/ext/db_ext/sybase/scripts/


4. Choose File > Browse File System for Restore Scripts. The xbp dialog is displayed. 

5. Select the restore script from the Files pane. 

6.	 Choose Restore > Restore Database Using Selected Scripts. The xbp_confirm dialog 
is displayed. 

7.	 Click OK. 

A NetBackup process called bphdb starts the Sybase backup script on the client. 

8. View the status of the script execution. 

a.	 Choose Restore > Report Progress Of Restore.... 

The xbp_progress dialog is displayed. 

b. Select the log file for your restore. 

The Contents of Selected Log File pane displays only the status of the script 
execution. A status =0 message indicates that the script was successfully 
completed. Go to Step 9 for a detailed status report. For a status other than 0, refer 
to the Troubleshooting section of this manual. 

9. View the log file for the NetBackup operation. 

a.	 Change directories to the bphdb log directory. 

cd /usr/openv/netbackup/logs/bphdb 

b. Open the log file with the tail option. 

tail -f log.mmddyy


A Restore completed SUCCESSFULLY message indicates a successfully completed 
NetBackup operation. 
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Using isql to Restore a Sybase ASE Database 
The steps required to recover a Sybase ASE database depend on the database that is 
involved and the problem that you have on your system. These steps can include: 

◆ Using buildmaster, installmaster, and installmodel for system databases 

◆ Re-creating database devices 

◆ Re-creating databases 

◆ Loading database dumps 

◆ Applying transaction logs 

Refer to the SYBASE SQL Server System Administration Guide for detailed instructions on 
performing these actions. 

A load can take significantly longer than a dump. The time required to load a database is 
proportional to the overall number of pages in the database. The load database 
command loads all used pages from the dump into the target database and runs recovery 
of syslogs to ensure consistency. The load process initializes any unused pages. 

You can load database and transaction dumps by manually submitting the Sybase ASE 
LOAD command to SQL Server. See the SYBASE SQL Server System Administration Guide 
for details on using the Sybase ASE LOAD command. 

Note The LOAD command must include the appropriate dump-file name. 

Refer to “Instructions for Modifying Restore Scripts for Use with Sybase ASE” on page 63 
for information about editing the LOAD command with the correct dump-file name. Note 
that the database dump and all of the transaction logs must be loaded before the database 
is brought back online. 

For example: 

load database mydb from "sybackup::SYBASE.mydb.D.0.14693.12-12-1997.09:29:37 -SERV saturn"

go
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Redirected Restore Configuration on the Client 
If you want to browse and restore backups that are owned by another client, perform the 
following: 

1.	 Ensure that the NetBackup server is configured to allow the redirected restore (see the 
NetBackup System Adminstrator’s Guide for Windows, Vol. I or the NetBackup System 
Administrator’s Guide for UNIX, Vol. I). 

2.	 Specify either of the following (if you specify both, NetBackup considers them in the 
order listed). 

◆	 Specify client name on the Sybase ASE LOAD command with the -CLIENT and 
-SERV option. For example, the following command specifies saturn as the client 
to browse: 

load database mydb from "sybackup::SYBASE.mydb.D.0.14693.12-12-1997.09:28:37 -SERV candytuft 

CLIENT saturn"

go


◆	 Specify client name with the CLIENT_NAME option in the $HOME/bp.conf or 
install_path/netbackup/bp.conf file on the client. For example, the following 
command specifies saturn as the client to browse. 

CLIENT_NAME=saturn

84 NetBackup for Sybase System Administrator’s Guide for UNIX 



Troubleshooting 
5


NetBackup, NetBackup for Sybase on UNIX, and the Sybase Backup Server all provide 
reports on database operations. These reports are useful for finding errors associated with 
those applications. 

This chapter contains the following sections. 

◆ NetBackup and NetBackup for Sybase on UNIX Logs 

◆ Setting the Debug Level 

◆ Sybase Backup Server Logs and Messages 

◆ Preventing Timeout Failures on Large Database Restores 
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NetBackup and NetBackup for Sybase on UNIX Logs 
The NetBackup server and client software allow you to set up detailed debug logs for 
troubleshooting problems that occur outside of either NetBackup for Sybase on UNIX or 
the Sybase Backup Server. See the NetBackup Troubleshooting Guide for UNIX and Windows 
for a complete description of debug logs. Also see the 
install_path/netbackup/logs/README.debug file. 

Note	 These logs do not reveal errors that occur during the execution of the Sybase 
Backup Server, unless those errors also affect NetBackup for Sybase. Sybase may (or 
may not) use the NetBackup for Sybase logs for errors in the application. Your best 
sources for Sybase error information are the logs provided by Sybase. 

Note In general, each debug log corresponds to a NetBackup process and executable. 

▼ To enable the NetBackup for Sybase logs 

1. Create the following directories on the client: 

install_path/netbackup/logs/bphdb

install_path/netbackup/logs/sybackup


% cd install_path/netbackup/logs/

% mkdir bphdb

% mkdir sybackup


2. Set the access permissions to 777 on these log directories. 

% chmod 777 bphdb 

% chmod 777 sybackup


If you create a debug log directory on the client, NetBackup for Sybase on UNIX records 
the dump-file name in the resulting debug log. The debug log directory that you must 
create is: 

/usr/openv/netbackup/logs/sybackup


The following is an example debug log: 
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NetBackup for Sybase on UNIX sends an informational message that specifies the 
dump-file name to Sybase Backup Server. 

The following sections describe the logs created when you create the log directories. Use a 
text editor to view the contents of the logs. 

bphdb Directory on the Client 

The install_path/netbackup/logs/bphdb directory contains the following types of logs. 
These logs are a good starting place to determine what type of error occurred. 

sybase_stdout.mmddyy 

Unless redirected elsewhere, NetBackup places Sybase backup script output 
in this file. 

sybase_stderr.mmddyy 

Unless redirected elsewhere, NetBackup places Sybase backup script errors in 
this file. 

log.mmddyy 

bphdb is the NetBackup Database Backup binary. This log contains 
debugging information for the bphdb process. NetBackup for Sybase on 
UNIX uses this client process for Sybase backup script execution. It is invoked 
when an automatic backup schedule is executed. 

sybackup Directory on the Client 

The install_path/netbackup/logs/sybackup directory contains the following 
execution log. 

log.mmddyy 

This log contains debugging information and execution status for the Sybase 
NetBackup client processes linked to the library program provided with 
NetBackup for Sybase on UNIX. 

install_path/netbackup/logs/

Chapter 5, Troubleshooting 87 



Setting the Debug Level 
NetBackup Server Reports 
NetBackup provides other reports that are useful in isolating problems. One such report is 
All Logs Entries on the server. See the NetBackup System Administrator’s Guide for Windows, 
Volume I or NetBackup System Administrator’s Guide for UNIX, Volume I for a description of 
this and other reports. 

Setting the Debug Level 
You can control the amount of information written to the debug log in the 
install_path/netbackup/logs/ directories by changing the Database debug level. The 
higher the value, the more information is logged. In everyday normal operations, the 
default value of 0 is sufficient. However, VERITAS Technical Support may ask you to set 
the value higher when a problem is being analyzed. 5 is the highest possible setting. 

❖	 To change the Debug Level, enter the following line in the bp.conf file. 

VERBOSE = 5 
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Sybase Backup Server Logs and Messages 
The Sybase Backup Server log provides information on the Sybase Backup Server part of 
the operation. This is the log that the database administrator must check to determine the 
ultimate success or failure of the database backups and restores. 

DUMP and LOAD Progress Messages 
Sybase Backup Server sends its dump and load progress messages to the client that 
initiated the dump or load request. When you use NetBackup to start Sybase backups, 
NetBackup for Sybase on UNIX routes Sybase Backup Server progress messages to the 
following file: 

install_path/netbackup/logs/bphdb/sybase_stdout.mmddyy.hhmmss.txt


If the install_path/netbackup/logs/bphdb/ directory does not exist, the messages 
are not written. 

ERROR Logging 
Sybase Backup Server performs its own error logging in the file that you specify when you 
configure Sybase Backup Server. See the SQL Server Configuration Guide for more 
information. 

Informational and error messages sent to the Sybase Backup Server log file include 
messages from the Archive API. You can enable detailed diagnostic tracing for the 
Archive API by specifying the -DTRACEIO option on the backup server command 
line. 

Note	 To determine successful status of DUMP and LOAD commands, always check Sybase 
Backup Server messages and logs. 

Here is an example of a Sybase Backup Server message log that indicates successful DUMP 
command completion: 

Backup Server: 3.43.1.1: Dump phase number 1 completed.

Backup Server: 3.43.1.1: Dump phase number 2 completed.

Backup Server: 4.58.1.1: Database model: 238 kilobytes DUMPed.

Backup Server: 3.43.1.1: Dump phase number 3 completed.

Backup Server: 4.58.1.1: Database model: 242 kilobytes DUMPed.

Backup Server: 3.42.1.1: DUMP is complete (database model).
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Preventing Timeout Failures on Large Database Restores 
Large database restores sometimes fail when multiple restore sessions compete for 
resources. In this situation, a restore session can be delayed waiting for media or device 
access. If the delay is too long, the restore session times out. 

This problem can be resolved by increasing the Client Read Timeout property, which 
prevents session timeouts and allows the restores to complete successfully. 

Use the NetBackup Administration Console on the server to change the properties of each 
client that contains a database you may need to restore. The Client Read Timeout 
property is found on the Timeouts host properties dialog of the master and media servers. 
The default for the Client Read Timeout setting is 300 seconds (5 minutes). For database 
agent clients, increase the value significantly to prevent timeout errors, e.g. 30 minutes. 
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